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RAE Systems Product Line

= Gas Detection Tubes & Pumps

= SampleRAE Electronic Sampling Pump

= MultiRAE PLUS Multi-gas Monitors

= MultiRAE IR Multi-gas Monitors w/CO»

= MultiRAE Confined Space Monitor

* QRAE PLUS Multi-gas Monitors

* QRAE Confined Space Monitor

*» VRAE Five-Gas Monitors

= DRAE Two-Gas Monitors

= MiniRAE 2000 Portable VOC Monitor (PID)

= ppbRAE Portable ppb-Level VOC Monitor (PID)
= UltraRAE Specific Compound Monitor

= CDRAE Corona Discharge VOC Monitor

= ToxiRAE PLUS PID Monitor

= ToxiRAE PLUS Single Gas Monitors

= ToxiRAE PLUS Oxygen Monitor

= ToxiRAE PLUS Combustible Gas Monitor

= MiniRAE PLUS Classic PID

* ModuRAE Fixed System PID

= AreaRAE Wireless Multi-point, Multi-gas Systems

How can | be informed and updated?

Be sure to mail in your warranty card via email, post or fax to get on
RAE’s private database (information is never supplied to others).

You will be updated on new products, technical advisory notices, new
accessories and much more. Thank you for your purchase!
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/N WARNING ! /\

- DO NOT proceed before reading -

This manual must be carefully read by all
individuals who have or will have the responsibility
for using, maintaining, or servicing this product.
The product will perform as designed only if it is used,
maintained, and serviced in accordance with the
manufacturer's instructions.

CAUTION!
To reduce the risk of electric shock, turn off power
before removing the monitor cover. Disconnect the
battery before removing sensor module for service.
Never operate the monitor while the cover is
removed. Remove monitor cover and sensor
module only in an area known to be non-hazardous.

The model PGM-50Q equipment is classified as to
intrinsic safety for use in class I, division 1, groups
A, B, C, D, or non-hazardous locations only.




Special Notes

-1-

When the Q-RAE monitor is taken out from the
transport case and turned on for the first time, there
may be some residual organic or inorganic vapors
trapped inside the detector chamber. The initial toxic
sensor reading may indicate a few ppm. Place the unit
in an area free of organic or toxic vapors and turn on
the monitor. After running for several minutes, the
residual vapors in the detector chamber will be cleared
and the reading should return to zero.

-

The battery of the Q-RAE monitor will discharge slowly
even if it is turned off. If the monitor has not been
charged for 5-7 days, the battery voltage will be low.
Therefore, it is a good practice to always charge the
monitor before using it. It is also recommended to fully
charge the monitor for AT LEAST 10 HOURS before
initial use. See Section 7 for more information on
battery charging and replacement.



WARNINGS:

Use only RAE Systems battery packs, part numbers
500-0028, 500-0029, 500-0037, or 500-0039. This
instrument has not been tested in an explosive gas/air
atmosphere having an oxygen concentration greater
than 21%. Substitution of components may impair
intrinsic safety.  Recharge batteries only in non-
hazardous locations.

AVERTISSEMENT:

Utiliser seulement I'ensemble de batterie RAE Systems,
les references 500-0028, 500-0029, 500-0037, ou 500-
0039. Cet instrument n’a pas été essayé dans une
atmosphere de gaz/air explosive ayant une
concentration d’oxygéne plus élevée que 21%. La
substitution de composants peut compromettre la
sécurité intrinsique. Ne charger les batteries que dans
I’emplacements désignés non-dangereux.

STATIC HAZARD:
Clean only with a damp cloth.

DANGER RISQUE D'ORIGINE
ELECTROSTATIQUE:
Nettoyer uniquement avec un chiffon humide.

CAUTION:
For safety reasons this equipment must be operated and
serviced by qualified personnel only. Read and
understand instruction manual completely before
operating or servicing.
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ATTENTION:
Pour des raisons de sécurité, cet équipment doit étre
utilisé, entretenu et réparé uniquement par un
personnel qualifié. Etudier le manuel d’instructions en
entier avant d’utiliser, d’entretenir ou de réparer
I’équipement.

CAUTION:

Before each day’s usage, sensitivity must be tested on a
known concentration of methane gas equivalent to 20-
50% of full scale concentration. Accuracy must be
within -0-+20% of actual. Accuracy may be corrected
by calibration procedure.

ATTENTION:
Avant chaque utilisation journaliere verifier la
sensibilité avec une concentration connue de methane
equivalente a 20 - 50% de la pleine échelle. La précision
doit étre comprise entre 0 - 20% de la valeur vraie et
peut étre corrigée par une procédure diétalonnage.

CAUTION:
Any rapid up-scale reading followed by a declining or
erratic reading may indicate a gas concentration
beyond upper scale limit which may be hazardous.

Vil




AVERTISSEMENT:
Toute lecture rapide et positive, suivie d’une baisse
subite au erratique de la valeur, peut indiquer une
concentration de gaz hors gamme de détection qui peut
étre dangereux.

WARNING:
The calibration of all newly purchased RAE Systems
instruments should be tested by exposing the sensor(s)
to known concentration calibration gas before the
Instrument is put into service for the first time.

For maximum safety, the accuracy of the Q-RAE
should be checked by exposing the sensor(s) to known
concentration calibration gas before each day’s use.

AVERTISSEMENT:
La calibration de toute instruments de RAE Systems
doivent étre testé en exposant I’instrument a une
concentration de gaz connue par une procédure
diétalonnage avant de mettre en service I’instrument
pour la premiére fois.

Pour une securite maximale, la sensibilité du Q-RAE
doit étre verifier en exposant I’instrument a une
concentration de gaz connue par une procédure
diétalonnage avant chaque utilisation journaliere.
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GENERAL INFORMATION

1. GENERAL INFORMATION

Q-RAE is a programmable Multi-gas monitor designed to

provide continuous exposure monitoring of oxygen,

hydrogen sulfide, carbon monoxide and combustible gases

for workers in hazardous environments. It monitors with

two types of sensors:

(1) Combustible gases are monitored with catalytic
bead sensors.

(2)  Oxygen, hydrogen sulfide and carbon monoxide are
monitored with electrochemical sensors.

Other features include:

o Lightweight and Compact
- 16 0z (454 g), hand-held size.

o Dependable and Accurate
- 10 hours monitoring with micro-controller.

o User Friendly
- Menu driven, intuitive end-use operation.

o Programmable Alarm Thresholds
- Audio buzzer & flashing display alarm.

Q-RAE consists of: A multi-gas monitor, a battery
charger, rubber boot, alkaline battery adapter, water and
dust filter, plus calibration accessories.



GENERAL INFORMATION

1.1 General Specifications

Table 1.1
Multi-gas Monitor Specification

Configuration: Pumped four-gas; datalogging option
Dimensions: 4.65”L x 3.0"W x 1.9"H

(11.8cmx 7.6 cm x 4.8 cm)
Weight: 16 oz (454 g) with battery.
Attachment: Rubber boot, wrist strap, belt clip.
Sensors: Four sensors (oxygen, combustible,

hydrogen  sulfide and carbon
monoxide), electrochemical sensors
for toxic gases and oxygen, catalytic
sensors for combustible gases.

Battery: Rechargeable, 4.8V/1100 mAh Li ion
or 4.8V/1700 mAh, Ni-Cd battery
pack with built-in charger (8-hour
charge time) or a 4 AA alkaline
battery adapter.

Operating Time:  Up to 10 hours continuous operation.

Display: 2 line, 16 digit LCD with LED back
light automatically in dim light.

Keypad: 1 operation and 2 programming keys.

Direct Readout: Four instantaneous value readings,
sensor names, high and low values for
all detectors, battery voltage and

elapsed time.
(Continued)




GENERAL INFORMATION

Multi-gas Monitor Specification

(Continued)

Range, Resolution and Response Time (tg):

Alarm:

Alarm Settings:

Calibration:

Sampling Pump:

Protection:

Intrinsic Safety:

EM Immunity:

Data Storage:

LEL 0-100 % 1% 15 sec
(O] 0-30 % 0.1% 15sec
CO 0-500ppm 1ppm 20 sec
H,S 0-100 ppm 1ppm 30 sec

90 dB buzzer and flashing red LED to
indicate exceeded preset limits, low
battery, or sensor failure.

Separate alarm limit settings for
TWA, STEL, Low and High alarm.

Two-point field calibration for fresh
air and standard reference gas.

Internal integrated with 250 cc/min
flow rate (high setting).

Password protected calibration
settings, alarm limits, and data.

UL & cUL Class 1, Division I, Group
A, B, C, D (US & Canada), EEx ia
IIC T4 (Europe). Class T3c with Li-
ion 500-0037 battery pack.

No effect when exposed to
0.43mW/cm2 RF interference (5-watt
transmitter at 12 inch).

20,000 readings (64 hours, 5 channels
at 1 minute interval) in non-volatile

memory.
(Continued)
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GENERAL INFORMATION

Multi-gas Monitor Specification

Alarm Settings:

Datalog Interval:

External Alarm:

Communication:

Temperature:
Humidity:

(Continued)

Separate alarm limit settings for
TWA, STEL, Low and High alarm.
Programmable 1- 3600 sec.

Optional plug in pen size vibration
alarm or earphone.

Upload data to PC and Download
monitor setup from PC through RS-
232 link to serial port on PC.

-200 to 450C (-40t0 1130 F).

0 % to 95% relative humidity.
(non-condensing)




OPERATION

2. OPERATION OF Q-RAE

The Q-RAE is a hand-held, portable Multi-gas chemical
exposure monitor. It gives real time measurements and
activates alarm signals whenever the exposure exceeds
preset limits or oxygen is depleted. Prior to factory
shipment, the Q-RAE is preset with default alarm limits
and the sensors are pre-calibrated with standard calibration
gas. However, the user should calibrate the instrument
before the first use. After the monitor is fully charged and
calibrated, it is ready for immediate operation.




OPERATION

2.1 Physical Description

Figure 2-1 shows the main components of the Q-RAE
Multi-gas Monitor, which include:

Gas entry port

Buzzer
Charge contact

Serial port

Wrist strap
LED alarm

Key

Figure 2-1 Major parts of the Q-RAE
Multi-gas Monitor

. 3 keys for the user to interact with the monitor: 1
operation key and 2 programming keys for normal
operation or programming of the monitor.

. LCD display with backlight to show real time and
calculated measurements.



OPERATION

Buzzer and red LED for alarm signal whenever the
exposures exceed preset limits.

Wrist strap.

Charge contact for plugging directly to the charging
station.

Gas entry port.

Serial communication port for PC interface.



OPERATION

2.2 Keys and Display

Figure 2-2 shows the LCD display and the keypad on the
front panel of the monitor. The functions of the 3 keys
during normal operation are summarized in Table 2.1 on
the next page:

LED alarm/
co HoS charge status
]/ |sensor
—1 O
0.1 0.0 ON
(0.0 20.9,
; 280
LECHROE N
/ l T L [Mode]
LEL [Y/+] Key [N/-] Key OXY Key

Figure 2-2  Key-pad and display of the Q-RAE
Multi-gas Monitor
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Table 2.1
Key Function in Normal Operation
[MODE]: Turn on/off the power* and choose
different display mode.
[N/-]: Toggle on/off the back light. Answer as
GIN0.11
[Y/+]: Alarm test and alarm acknowledgment

(turn off latched alarm, turn on pump or
LEL sensor). Answer as “Yes.”

* Pressing and holding [MODE] for 5 seconds turns off the
power to the monitor. Monitor will beep once per second
during power-down sequence. Press [MODE] momentarily
to choose different display modes (see Section 2.4 for
details).




OPERATION

The Multi-gas Monitor includes a 2-line, 16-digit dot
matrix LCD display. The LCD shows the following eight
types of displays during normal operation if the [MODE]
key is pressed:

Real time instantaneous gas concentration in ppm
for H,S and CO, % by volume for oxygen and
%LEL for combustible gases.

Sensor names.

Peak and minimum gas concentrations for H,S and
CO, oxygen and combustible gases.

15 minute Short Term Exposure Level (STEL)
values of H,S and CO in ppm and 8-hour Time
Weighted Average (TWA).

Battery voltage and shut off voltage in volts.
Real time clock, run time and temperature.

Datalogging mode or “Start /Stop Datalog?” menu
to enable/disable datalogging if manual datalogging
mode is selected.

LEL gas names (if the LEL sensor is installed).

“Print Reading?” menu to print the reading to the
RAE Printer (only shown when enabled; normally
this function is disabled and not shown).

“Communicate with PC?” menu to send or receive
data between PC and the Q-RAE monitor.



OPERATION

2.3 Power On/Off

To turn on the Q-RAE Multi-gas Monitor, press [MODE]
key. The audio buzzer will beep once and the display will
show “ONL..” and then “MultiGas Monitor Ver n.nn” to
indicate the software version number. The custom power-
on-name which can be changed by the customer using the
ProRAE Suite Software. The model number, serial
number, current date and time, temperature of the monitor
are displayed next. The monitor will then go through each
sensor socket to check if a valid sensor is installed. If a
new sensor is installed, a message to remind the user to
calibrate the sensor will be displayed followed by a
message that the alarm limits have been reset to default
values for the new sensor. If a sensor reaches its expected
end of life, a “Warranty Expired” message will be
displayed.

Next, the monitor displays the preset alarm limits for each
sensor, battery voltage, shut off voltage, user mode, alarm
mode, datalog mode, available data storage memory (in
hours), datalog mode and datalog interval (in seconds).
After several more seconds delay, the display shows the
instantaneous reading of the gas concentrations and is
ready to monitor gases.

To turn off the Q-RAE Multi-gas Monitor, press and hold
the [MODE] key for 5 seconds. Monitor will beep once per
second during the power-down sequence with a count
down timer showing the number of remaining seconds.
The message “Off!..” flashes on the LCD display and the
display will go blank, indicating that the monitor is turned
off.

2-7



OPERATION

Turning off the Multi-gas monitor with the AC charger in
place will result in a display of “Charging..” or “Battery
Charged” and indication of battery voltage. This indicates
that the monitor is off, but the smart charger circuit is now
active.

To turn the unit on from the charge or discharge mode,
press the [MODE] key.

Data protection during power off

When the monitor is turned off, all the current real time
data including TWA, STEL, Peak and elapsed time are
erased. However, the datalog data is preserved in non-
volatile memory. Even if the battery is disconnected, the
datalog data will not be lost. During the power off period,
the real time clock will continue to operate until the battery
iIs completely drained (usually in 5-7 days without any
charging). If the battery is completely drained or is
disconnected from the monitor for more than 30 minutes,
the real time clock will be lost. In this case, it is necessary
to enter the real time clock information again, as described
in Section 4.
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Datalogging versus Non-datalogging monitors

The Q-RAE Multi-gas Monitors are available in both
datalogging and non-datalogging versions. During power
on sequence, a letter “D” following the version number
indicates that the monitor is configured as a Datalogging
monitor. Without the letter “D”, it is a Non-datalogging
monitor.

Users can upgrade a Non-datalogging monitor to a
Datalogging monitor. Call the factory for information on
how to order the upgrade kit and follow the instructions
described in Section 5.7 to enable or disable the
datalogging feature for the monitor.
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2.4 Operations

The Q-RAE Multi-gas Monitor offers three different user
modes of operation:

Text mode,
Display mode, and
Programming mode (default mode setting).

The text mode is the simplest mode of operation. The
monitor will display the sensor name after the monitor is
turned on. The user can press the [MODE] key to see the
instantaneous gas concentration reading, battery voltage or
enter the PC communication menu. The user can get into
the calibration mode from text mode to do calibrations, but
cannot change most of the parameters.

In the display mode, the Q-RAE Multi-gas Monitor is
able to display all the information in the text mode. In
addition, the following information is also available by
pressing the [MODE] key: peak, minimum, STEL, TWA,
run time in hours and minutes, temperature in °C, datalog
mode (or enable / disable datalogging operation in manual
datalog mode), LEL gas names, printing and
communication with a PC options. The user cannot get into
the calibration mode from display mode, so it is not
possible to calibrate or change any of the parameters.

In the programming mode, which is the default setting,
the user can perform all of the functions of the display
mode. In addition, the user can get into calibration mode,
perform calibrations and change any of the parameter in
the calibration mode.

2-10
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The following is the detailed explanation of the displays
when the [MODE] key is pressed

1) The instantaneous reading is the actual gas
concentration in parts per million (ppm) for toxic gases,
% of volume for oxygen and % of LEL for combustible
gases. The reading is updated once per second and is
shown in the LCD display.

0 0
20.9

2) The sensor names are displayed as:
LEL : for the combustible gas sensor
O2  : for the oxygen sensor
H»S : for the hydrogen sulfide sensor
CO : for the carbon monoxide sensor

CO H,S
LEL OoXY
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3)

4)

5)

The Peak reading is the highest reading of each gas
concentration since the monitor was turned on. The
reading is updated at one-second intervals and is
shown in the LCD display with a “Peak’” message.

5 3
10 Peak 20.9

The Minimum reading is the lowest reading of each
gas concentration since the monitor was turned on. The
reading is updated at one-second intervals and is shown
in the LCD display with a “Min” message.

0 0
0 Min 19.9

The STEL reading is the last 15 minute average
reading of the gas concentration. The reading is
updated once per minute and is shown in the LCD
display with “STEL” message. For the first 15
minutes, “****” will be displayed. This reading
applies to H,S and CO only.

STEL
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6) The TWA reading is the average reading of the gas
concentration times the fraction of 8 hours that the
monitor has been on.

TWA = Avg Reading x (Run time in hrs / 8 hrs)

The reading is updated once a minute and is shown in the
LCD display with “TWA” message. This reading applies
only to H,S and CO sensors. The TWA value always
increases, it can never decrease unless cleared.

TWA

7) The battery voltage reading is the current battery
voltage in volts. The reading is updated once per
second and is shown in the LCD display. The shut
down voltage is also shown. Note: A fully charged
battery pack should show 4.8 volts or higher. When
the battery voltage falls below 4.4 volts, a flashing
“Bat” will appear as a warning message. This means
there are 20-30 minutes run time left before the
monitor turns off automatically, when the battery
voltage falls below 4.2 volts.

Battery = 4.8V
Shut down at 4.2V
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8)

9)

The run time reading is the accumulated “On” time
in hours and minutes since the monitor was turned on.
The reading is updated at one-minute intervals and is
shown in the LCD display together with the current
date, time and temperature.

8/3/96 8:30
On = 3:50 20°C

The datalog menu shows the current datalog mode. If
manual datalog mode is selected, the menu will prompt
the user to turn on or off datalogging. Pressing the
[Y/+] key while the “Start Datalog?” message is
displayed turns on the datalogging. Likewise, pressing
the [Y/+] key while “Stop Datalog?” message is
displayed turns off the datalogging.

10) The monitor will display the selected LEL gas name if

11)

the combustible sensor is installed. When the selected
LEL gas is different than the calibration gas, a
programmed correction factor for that specific gas is
multiplied by the readings and the corrected gas
concentrations are displayed.

Print Reading? allows printing the gas concentration
readings. If a serial printer is connected and ready,
press [Y/+] to print the readings. This function is
shown only when enabled; the default setting is
disabled and the display is not shown.
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12) Communicate with PC? allows the user to
upload data from the Q-RAE to a Personal Computer
(PC) or download configuration information from a PC
to the Q-RAE. Press the [Y/+] key and the LCD
displays the message “Monitor will pause, OK?” to
remind the user that during PC communication, there
will be no real time monitoring of the gas
concentration. Press [Y/+] to proceed and the monitor
enters the communication standby mode. The LCD
then displays “Ready...” Connect the monitor to the
serial port of a PC. The monitor is then ready to
receive any command from PC (see Section 5 for
details on communications between Q-RAE and PC).

Note: When the monitor is in communication
standby mode, it stops monitoring the gas
concentration and stops datalogging.
Datalogging must be manually restarted when
exiting the communication standby mode, unless
it is in automatic datalogging mode.
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Displays in different user modes:
See Appendix A. for more information

1. TEXT MODE

Display Instantaneous Reading & Sensor Names alternately

[N]+[MODE] for 3 seconds:
Password check
Wrong password: back to instantaneous display
Correct password: Enter Programming menu.
[N]: Toggle back light  [Y]: Test alarm/stop alarm

[MODE]

Display Battery voltage

[MODE]

Print Reading? (if printer option is enabled)

[MODE]

| Communicate with PC?

[Y1: Monitor will pause OK?
[Y]: Ready...
[N]: Return to Instantaneous display & Sensor names alternately

[MODE] or [N]

| Return to Instantaneous Display & Sensor Names alternately
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2. DISPLAY MODE

Display Instantaneous Readings & Sensor names alternately

[N]+[MODE] for 3 seconds:
Password check
Wrong password: back to instantaneous display
Correct password: Enter Programming menu.
[N]: Toggle back light  [Y]: Test alarm/stop alarm

[MODE]

Display Peak values

[MODE]

Display Min values

[MODE]

Display STEL values

[MODE]

Display TWA values

[MODE]

Display Battery voltage

[MODE]

Print Reading? (if printer option is enabled) |

[MODE]

Communicate with PC? |

[Y1: Monitor will pause OK?
[Y]: Ready...
[N]: Return to Instantaneous display

[MODE] or [N]

Return to Instantaneous display & Sensor names
alternately
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2.5 Alarm Signals

The built-in - microcomputer constantly updates and
monitors gas concentration and compares it with the
programmed alarm limits (TWA, STEL, and two
Instantaneous gas concentration alarm limit settings: Low
& High). Whenever the concentration exceeds any of the
preset limits, the loud buzzer and red flashing LED are
activated immediately to warn the user of the alarm
condition.

In addition, the Q-RAE will alarm if one of the following
condition occurs: battery voltage falls below a pre-set
voltage level (4.4 V), LEL sensor off, pump stall or when
the datalog memory is full. When the low battery alarm
occurs, there will be approximately 20-30 minutes of
operating time remaining. When the battery voltage falls
below 4.2 V, the monitor will be turned off automatically.

Alarm Signal Disabled: It is extremely important
to note that during the following conditions, the
alarm signals are disabled:

1) In PC communication standby mode.
2) In calibration mode (including reviewing
datalog data).

During these modes of operation, real time monitoring of
the gas concentration stops. None of the gas
concentrations will be calculated, including Peak, STEL
and TWA.
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Alarm Signal Latching:

It is possible to setup the Q-RAE from a PC or in
programming mode so that when an alarm condition
occurs, the alarm signals stay on even after the alarm
condition is no longer present. This is called the “latching

alarm” mode.

The alternative mode is to automatically

reset the alarm signal when the alarm condition is cleared.
The default alarm mode is automatic reset (see Chapter 4
or 5 for details on how to set alarm mode).

Alarm Signal Summary:

The various alarm signals are summarized here:

Condition Alarm Signal

Gas exceeds “High | 3 beeps/flashes per second plus

Alarm” limit sensor name on LCD

Gas exceeds “Low | 2 Dbeeps/flashes per second plus

Alarm” limit sensor name on LCD

Gas exceeds STEL | 1 beep/flash per second plus sensor
name on LCD

Gas exceeds TWA | 1 beep/flash per second plus sensor

name on LCD

Negative Drift or

3 beeps/flashes per second plus NEG

Over Range or OVR name on LCD

Pump failure 3 beeps/flash per second plus
“Pump” message on LCD

LEL sensor off 3 beeps/flash per second plus LEL
sensor name and “Off” message on LCD

Low battery 1 flash per second, 1 beep per minute

plus “Bat” message on LCD
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Memory full 1 flash per second plus “Mem”
message on LCD

Alarm Signal Testing:

Under normal non-alarm conditions, it is possible to test
the Q-RAE LED, buzzer and backlight by pressing the
[Y/+] key momentarily. The buzzer will beep once and the
LED and back light will flash once to indicate that these
alarm signals are functioning correctly.

WARNING:

The alarm signals are disabled during PC
communication, calibration or datalog review
operation. To reduce the risk of exposure to
hazardous atmospheres, perform PC
communication, calibration or datalog review
only in area known to be non-hazardous.
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2.6 Backlight

The LCD display is equipped with an LED back light to
assist in reading the display under poor lighting conditions.
This back light can be turned on manually by pressing and
holding the [N/-] key for one second in normal operation.
The backlight can be turned off by pressing [N/-] a second
time. If the [N/-] key is not pressed, the back light will
turn off automatically after a pre-programmed time-out
period to save power.

In automatic mode, the ambient light is sensed and the
backlight will be turned on automatically if the ambient
light is below a threshold level. The back light will be
turned off automatically when the ambient light exceeds
the threshold level.

(See Chapter 4 or 5 for details on how to set the back light
mode and time out period from the monitor or a PC. See
Chapter 8 for details on how to set the ambient light
threshold level)

Note: The LED back light consumes a higher amount of
energy from the battery and shortens the operating time of
the monitor by 20 - 30%.
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2.7 Preset Alarm Limits and Calibration

The Q-RAE Multi-gas Monitor is factory calibrated with
standard calibration gas, and is programmed with default
alarm limits as listed below (refer to Chapter 4 or Chapter
5 for programming procedures if new calibration or alarm
limits is required).

Table 2.2

Factory Calibration and Preset Alarm Limits

Gas | Cal Gas /| Unit TWA | STEL |Low High
ppm | Balance

LEL [SO0/AiIr [%LEL [N/A [N/A  [10% [20%

O, |AiIr % VOL |N/A | N/A [19.5% [23.5%

CO |50/ Air |ppm 35 |100 |35 200

H,S [25/N, |ppm 10 |15 10 20
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2.8 Integrated Sampling Pump

The Q-RAE Multi-gas Monitor includes an integrated
sampling pump. This is a diaphragm pump providing
about 250 cc per minute flow rate at the high setting.

A low pump speed of about 150 cc per minute is the
factory default setting, which will increase the battery life
by about 5% and result in an increased LEL sensor
lifetime. See Chapter 4 or 5 for details of how to select the
pump speed.

The pump turns on automatically when the monitor is
turned on and remains on during normal operation.

If liquid or other objects are sucked into the water trap
filter in the inlet port and cause the pump to stall, the
monitor detects the obstruction and shuts down the pump
immediately. The alarm is activated and a flashing error
message “Pump” is also displayed.

Remove the obstruction and press [Y/+] to acknowledge
the pump shut off condition and re-start the pump.
Different pump shut-off thresholds are desired for the two
pump settings; this value can be adjusted in the Special
Diagnostic Mode as described in Section 8.1.
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2.9 Datalogging

The Q-RAE Multi-gas Monitor calculates and stores the
gas readings based on a user-specified datalogging period
and the type of measurement. Two types of gas
measurements, average or peak concentration can be stored
for each sensor during each datalogging interval. The
datalogging interval can be programmed from one second
to 60 minutes in one-second increments. In addition, time
stamp, user 1D, site ID, serial number, last calibration date,
and alarm limits are also stored. All data are retained in a
non-volatile memory so that they can be down loaded at a
later time to a PC.

Datalog Options

There are four ways to initiate the datalog operation:

- automatic: start and stop datalogging automatically
when the monitor is turned on and off.

- manual: start and stop datalogging by pressing a key
manually. There is a timer available to setup the
maximum datalogging time.

- periodic: start and stop datalogging daily based on preset
time (hour and minute).

- scheduled: start and stop datalogging based on preset
date and time (month, date, hour and minute).

Choose a datalog option

Most of the datalogging options can be programmed from
the monitor. Additional options can be programmed using
a PC and downloaded to the monitor (see Chapter 5 for
details on how to program various datalogging options).
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Start/stop datalogging manually

If manual datalogging mode has been selected from the
normal operation menu, toggle through the menu using the
[MODE] key until the “Start Datalog?” prompt is
displayed. Pressing the [Y/+] key turns on datalogging.
Likewise, pressing the [Y/+] key while “Stop Datalog?”
is being displayed, turns off datalogging.

The other three datalogging options will start and stop
automatically without any user intervention:

Datalogging event

Each time a datalogging operation is initiated, a datalog
event is created. Information, such as start time,
datalogging period, alarm limits, etc. will be recorded in
the event header, followed by the measurement data. |If
more than 900 measurement intervals are recorded in one
event, a new event will be created automatically.

Datalogging pause

Under the following conditions, the datalogging will be
paused automatically:

1) When entering programming mode, datalogging will
stop. Upon exiting the programming mode, the
datalogging will resume.

2) When entering PC Communication standby mode,
datalogging will stop. Upon exiting the PC
communication standby mode, datalogging will resume
only if datalogging mode was set to automatic
mode.

In either case, a new datalog event will be created when
the datalogging is resumed.
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3. OPERATION OF ACCESSORIES
The accessories for Q-RAE include:

« Battery charger

« Alkaline battery adapter

« Water trap filter and remote sampling probe

o Dilution fitting

« Calibration adapter

WARNING:
To reduce the risk of ignition of hazardous
atmospheres, recharge battery only in areas
known to be non-hazardous. Remove and
replace batteries only in areas known to be non-
hazardous.

Ne charger les batteries que dans
I’emplacements désignés non-dangereux.
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3.1 Battery Charging Operation

The charging circuit of the Q-RAE is built into the
monitor. It only needs a regular AC to 12 VV DC adapter
(wall mount transformer) to charge the monitor.

1.

2.

3.

Connect the AC adapter (or the optional automotive
charging adapter) to the DC jack on the Q-RAE
monitor.

If a NiCd battery is installed, the display will ask
whether a discharge cycle (see NOTE on next page) is
required. Press [Y/+] to start a full discharge and [N/-]
to start the charging function. The display will show
“Charging” “Battery = x.x V.” If a key is not pressed
within ten seconds, the charging will begin
automatically.

Charging
Battery = 5.6V

The LED should be red in color when charging. If the
battery is fully charged, the LED will change from red
to green. The red color indicates that the battery is
being charged. The green color indicates that the
battery is fully charged. The display will also indicate
“Fully charged.” A completely discharged Q-RAE
monitor will be charged to full capacity within 10 hours.
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Note 1: The monitor recognizes whether a Li-ion or NiCd
battery is installed.

Note 2: For NiCd batteries only, perform an occasional
deep discharge to remove memory effects and maintain
full capacity. When the AC adapter is connected, the
display shows: Deep Discharge? Press the [Y/+] key.
The battery will begin a deep discharge followed by a
charge cycle.

Note 3: The latest version of the Q-RAE monitor has a
smart charging circuitry and algorithm. It may be left
connected to the charger indefinitely without damaging the
battery.

The battery of the Q-RAE monitor is drained slowly even
when the monitor is turned off. If the monitor has not been
charged for 5-7 days, the battery voltage may be low.

The NiCd battery is designed to last for 10 hours of normal
operation (no alarm, no back light condition) for a new
battery under the best condition. Extended life Li-ion
batteries can last for up to 20 hours. As the battery
becomes older or is subject to adverse conditions (such as
cold ambient temperature), the battery capacity may be
reduced significantly.
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3.2 Alkaline Battery Adapter

An alkaline battery adapter is supplied with each Q-RAE
kit. It accepts four AA size alkaline batteries and can be
used in place of the NiCd battery pack to provide
approximately 12-14 hours of operation. The adapter is
intended to be used in emergency situations when there is
no time to charge the NiCd battery

@

Figure 3-1 Alkaline Battery Adapter

To install the adapter, remove the cover of the monitor.
Unplug the NiCd battery pack from the battery connector
and plug the alkaline battery adapter into the battery
connector.

The internal charging circuit will automatically detect the
alkaline battery adapter and prevent charging of the
battery.

Note: The AA Alkaline battery adapter supplied
by RAE Systems Inc. is intrinsically safe!
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3.3 Water Trap Filter

The water trap filter is made of PTFE (Teflon®) membrane
with a 0.2 micron pore size to prevent liquid water from
being sucked into the sensor manifold, which would cause
extensive damage to the monitor. It will also prevent any
dust from entering the monitor and will prolong the
operating life of the sensors and the pump.

To install the water trap filter, simply slide the Tygon
tubing onto the barbed inlet port on the monitor. A male
Luer connector fits to the female Luer of the filter. To
remove the filter, disconnect the Luer connector.



OPERATION OF ACCESSORIES

3.4 Remote Sampling Probe or Tygon Tubing

An optional 6-foot Teflon remote sampling probe with a
telescoping handle or 15-foot Tygon tubing are handy
accessories for users to probe areas that are difficult to
reach, such as ceilings, storage tanks, underground man-
holes, etc. Connect the male Luer connector at the end of
the remote sampling probe or the Tygon tubing to the
female Luer connector on the water trap filter. The remote
sampling probe or the Tygon tubing is ready for operation.

Warning:

Tygon tubing is recommended only for volatile
compounds like methane, propane, CO, H»S, and O,. For
LEL measurements of higher hydrocarbons, it is
recommended to use Teflon tubing. For example, one
meter of Tygon tubing can completely absorb Jet fuel
vapors resulting in a false negative response. For heavy
fuels and other organic compounds, Teflon, metal or other
non-absorbing extension tubing are necessary.
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3.5 Dilution Fitting

An optional dilution fitting can be installed together with
the remote sampling probe or Tygon tubing on the gas inlet
port to dilute the gas samples. This fitting is needed if the
gas sample does not contain more than 15% of oxygen.
This is due to the fact that the combustible sensor will not
function correctly when the oxygen concentration falls
below 15%. The dilution fitting will increase the oxygen
concentration so that the combustible sensor can still be
used under oxygen deficient conditions. The other use of
the dilution fitting is to measure H,S or CO when the
concentration exceeds the upper limit of the sensor range.

To use the dilution fitting, simply insert the fitting between
the water trap filter and the remote sampling probe or
extension tubing. Make sure to set the dilution ratio in the
programming mode (see Section 4.8) so that the correct
gas reading will be displayed when the dilution fitting is
used.

WARNING: For this application, the user must
have the monitor located in a clean atmosphere
outside the confined space and use a remote
access probe or Tygon tubing to measure the gas
concentration.
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3.6 Calibration Adapter

The Q-RAE monitor is supplied with two calibration
adapters: a 6-inch piece of Tygon tubing with a male Luer
connector on one end, and a 3-inch piece of Teflon tubing
also with a male Luer connector. For calibration, simply
connect the Luer adapter to the water trap filter on the Q-
RAE monitor and the open Tygon or Teflon tubing to the
metal adapter from the calibration gas regulator.  The
Teflon adapter can also be used as a sampling probe during
normal operation, and is preferred for LEL measurements
of less-volatile compounds.
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4. PROGRAMMING OF Q-RAE

The Q-RAE Monitor is built with a microcomputer to
provide programming flexibility for the user. Authorized
users can re-calibrate the monitor, change the alarm limits,
change site ID, user ID, datalogging period, real time
clock, etc.

Programming is menu-driven to provide intuitive end-user
operation. The display shows the menu options, and the
key pad is used for menu selection and data entry.

Note: The real time monitoring of the gas
concentration continues while in the
programming mode. However, during the
calibration or review datalog procedures, the real
time monitoring will pause until the procedures

are completed. In  addition, entering
programming mode will pause the datalogging
operation automatically. After  exiting

programming mode, datalogging operation will
resume.
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4.1 Programming Mode

The Q-RAE has three user modes: text, display and
programming mode. The user can access the
programming function only if the wunit is in the
programming mode (or from text mode with a password).
If the monitor is set to display mode, the user cannot
enter the programming menu. In this case, the user mode
can be changed only through a PC (see Section 5.0 for
details on setting up the user mode).

The programming mode allows users to change the
setup in the monitor, calibrate the monitor and enter user
information, etc. The programming functions are organized
in a three-tier menu structure. Table 4.1 shows the first tier
of the programming menu. Each menu item includes
several sub-menus to perform additional programming
functions. Appendix A. shows a more detailed menu tree
structure.

Table 4.1
Programming Menu
Calibrate Monitor?

Change Alarm Limits?

View or Change Datalog?

Change Monitor Setup?
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Security Level

There are three levels of security in the Q-RAE
programming mode to provide further protection against
unauthorized changes to the monitor alarm settings and
other settings. Level 2 security allows a user to enter
programming mode without any restrictions. This is the
default security setting. Level 1 security requires a 4 digit
password to enter programming mode. Level O security
allows a user to enter the programming mode without any
password check, as in the Level 2. However, it does not
allow a user to save any changes to the alarm limits, real
time clock, correction factor, user and site information, etc.
A user can still perform calibration with Level 0 security.
The security level must be set using a PC (see Chapter 5
for details on setting up the security level).

Once inside the programming mode, LCD the first menu
will be displayed. To move through the menu, press [N/-]
repeatedly until the desired menu item is displayed. To
enter the sub-menu of a particular menu, press the [Y/+]
key and the sub-menu will be displayed.

To exit the programming mode and return to the normal
operation, press the [MODE] key at any of the first tier
menu displays.
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4.2 Keys for Programming Mode

The three keys perform a different set of functions during
the programming mode as summarized below.

Table 4.2
Key Function in Programming Menu
[MODE]: Exit menu when press momentarily or

exit data entry mode when pressed and
held for 1 second

[Y/+]: Increase numerical value for data entry
or confirm (yes) for a question

[N/-]: Decrease numerical value for data entry
or deny (no) for a question
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4.3 Entering the Programming Menu

Turn on the Q-RAE monitor (refer to Section 2.3 for
the power on sequence).

Press and hold down both [MODE] and [N/-] keys for
three seconds to enter programming mode. Note: This
Is to prevent a user from entering the programming
mode by accident.

If the security level is 0 or 2, after holding down the
two keys for 3 seconds, the monitor should enter the
programming mode and the first menu item “Calibrate
Monitor?” is displayed.

If the security level is 1, or the monitor is in text mode,
after holding down the two keys for three seconds, the
display shows “Enter Password = 0000” with the left-
most digit flashing. The user should enter a password
starting from this flashing digit.

Note 1: Prior to factory shipment, the Q-RAE monitor was

installed with “0000” as the default password.

Note 2: For added security, “0000” is always displayed

5.

instead of the actual password at this step.

If the correct digit value is not “0”, use [Y/+] or [N/-] to
increase or decrease the digit value. Then press
[MODE] momentarily to confirm the digit value. The
display shows the actual digit entered and moves the
flashing cursor to the next digit (to the right).
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. Repeat Step 5 until all four digits are entered. Press
and hold [MODE] for one second.

. If the entered password is correct, the monitor enters
the programming menu. The first menu item “Calibrate
Monitor?” is displayed.

. If the password is incorrect, the display shows “Wrong
Password???” and returns to the regular display of
instantaneous gas readings.

. If the User mode is set to display mode, a message
“Display Only! Cannot enter....” is shown.
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4.4 Calibration of Q-RAE Monitor

CALIBRATION WARNINGS:
The calibration of all newly purchased RAE Systems
instruments should be tested by exposing the sensor(s)
to known concentration calibration gas(es) before the
Instrument is put into service.

For maximum safety, the accuracy of the Q-RAE
should be checked by exposing the sensor(s) to known
concentration calibration gas before each day’s use.

In programming mode, the user may re-calibrate the
sensors in the Q-RAE monitor. This is a two-point
calibration process using “fresh air” and the standard
reference gas. First, “fresh air” containing 20.9% oxygen
and no detectable toxic or combustible gases is used to set
the zero point for the LEL, CO and H,S sensors and the
span for the O, sensor. Then a standard reference gas,
containng a known concentration of a given gas, is used to
set the second point of reference (also known as span gas)
for the first 3 sensors. The two-point calibration procedure
is detailed below. Table 4.3 shows the sub-menus for
calibration operations.
Table 4.3

Calibration Sub-Menu

Fresh Air Calibration?

Multiple Sensor Calibration?

Single Sensor Calibration?
Modify Span Gas Value?
Change LEL Span Gas?
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Q-RAE monitors can be calibrated either with gas from a
gas sample bag (Tedlar® bag), directly from a gas bottle
using a demand-flow type regulator, or from an open-tube
(also open cup or Tee) that allows excess gas to escape
past the inlet probe. In the latter method it is important that
the gas flow is greater than the pump draw by at least 20%.
The Q-RAE can also be calibrated directly from a cylinder
using a fixed flow regulator with a flow rate between 0.5
and 1.0 liters per minute, although this method is less
accurate than the other 3 methods by a few percent. The
calibration adapter links up the inlet port of the Q-RAE
Monitor to the gas sample bag (see Figure 4-1).

Figure 4-1 Connection of Calibration Gas
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4.4.1 Fresh Air Calibration

This procedure determines the zero point of the sensor
calibration curve (and span for Oj). The “fresh” air
required for zeroing is clean dry air with 20.9% oxygen
and without any organic, toxic or combustible gases or
related impurities, preferably from a pure air cylinder. If
such an air bottle is not available, any clean ambient air
without detectable contaminant can also be used. A
charcoal filter should be used if one is not sure of the
ambient air’s purity. Note: Charcoal filters remove most
organic vapors but will not remove methane, propane or
hydrogen.

1. “Calibrate Monitor?” is the first menu item in Table
4.1. Press [Y/+] to perform calibration. The first sub-
menu shows: “Fresh Air Calibration?”

2. If the “fresh” air bottle is available, twist the Luer
calibration adapter onto the inlet port of the Q-RAE
Monitor and connect the other end of the tube to the
fresh gas bottle. If the “fresh” air bottle is not
available, simply leave the monitor in an area free of
any detectable vapor or attach the charcoal filter.

3. Press [Y/+] to start fresh air calibration. The display
shows “zero ...in progress” followed by the name of
each sensor and the message “zeroed.” The display
should show a reading of “20.9” for the oxygen sensor
and “0.0,” or a very small number, for all other sensors.

4. After about a 5 second pause, the display will show the
message “Zero Cal Done! ” and move to the next sub-
menu “Multiple Sensor Calibration?”
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4.4.2 Multiple Sensor Calibration

This function simultaneously determines the second point
of calibration curves for multiple sensors in the monitor.

A four-gas mix (Typically CHy4, CO, H5S, Oy, balance Ny)
is needed to perform this procedure. Connect the monitor
to the sample bag filled with mixed gas as shown in Figure
4-1.

1. Continuing from Step 4 of the previous section, the
display should show “ Multiple Sensor Calibration?”
Press the [Y/+] key. The display shows all the pre-
selected gases for the sampling bag filled with mixed
gas and “OK?” question. Press [Y/+] key to accept the
multiple sensor selection and start the calibration, or
press the [N/-] key to modify the sensor selection and
go to Step 7.

CcO H,S
LEL  OK? OoXY

2. Turn on the valve of the sampling bag to start the flow
of the span gas. Display shows “Apply Mixed Gas”
and will wait for the calibration gas to reach the sensor.
When the calibration gas has reached the sensor the
display will show “calibration in progress... 60” with
the countdown timer shows the number of remaining
seconds while the monitor performs calibration. When
the countdown timer reaches 0, the display shows the
name of each sensor, the message “cal’ed!” and the
calibrated values for each gas. If no gas has reached
the sensor after 60 seconds, the display will show “ No
gas flow...” and abort the calibration.
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Note: The readings should be very close to the span gas
values. After about 5 seconds pause, the display will show
the message “Span Cal Done! Turn Off Gas.”

3.

This completes the multiple sensor calibration
procedure and moves to the next sub-menu item.

Turn off the flow of gas. Disconnect the calibration
adapter from the Q-RAE Monitor.

I the sensor failed the calibration, the sensor name and
an error message “failed, continue?” will appear. Press
the [N/-] or [MODE] key to abort the calibration and
move directly to the next sub-menu item. Press the
[Y/+] key to continue the next sensor calibration. In
either case, the calibration datum for the current sensor
is not changed.

From Step 1, if the [N/-] key is pressed, the display
shows all the sensor names that are selected for
multiple sensor calibration with the cursor blinking at
the first sensor location.

CO*  ----  H,S*
LEL* OK? O,

Press the [Y/+] key to select the sensor and the [N/-]
key to de-select the sensor. A previously selected
sensor will show an “*” next to the sensor name. A
previously de-selected sensor will not show an “*” next
to the sensor name.
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7. Press the [MODE] key momentarily to move from one
sensor location to the next one. Repeat Step 7 until all
of the sensors, which need to be calibrated during
multiple sensor calibration, are selected. Press and
hold the [MODE] key for 1 second to save the new
sensor selection.

8. The display shows “Save?” To confirm the new
selection, press the [Y/+] key to accept the change and
continue on with Step 2. Press the [N/-] key or the
[MODE] key to discard the change and to continue on
with Step 2.
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4.4.3 Single Sensor Calibration

This procedure determines the second point of the sensor
calibration curve for a single sensor. A standard reference
gas (span gas) is needed to perform this procedure. Table
2.2 shows the standard calibration gas that is typically used
as the span gas in the factory. Connect the tube to the
sampling bag filled with the standard gas as shown in
Figure 4-1 (or use one of the excess flow methods
described above).

1. Continuing from Step 4 or Step 6 of the previous
section, the display should show “Single Sensor
Calibration?” Press [Y/+] key. The display shows all
the installed sensors in the monitor with the cursor
blinking at the first sensor location. Press [Y/+] to
select the highlighted sensor and start the calibration, or
press [MODE] momentarily to move to the next sensor
location.

CO H,S
LEL  pick? OoXY

2. The monitor shows “Apply XXX Gas...” and waits for
the calibration gas to reach the sensor. Turn on the
valve of the gas bottle to start the flow of the span gas.
When the the sensor detects calibration gas, the display
shows “Calibration in Progress... 60” with the
countdown timer showing the number of remaining
seconds while the monitor performs calibration. This
automatic calibration start can be overridden by
pressing [Y/+] to start the calibration manually. When
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the countdown timer reaches 0, the display shows the
sensor name and the calibrated value:

CO cal'ed
reading = 50 ppm

If no gas has reached the sensor after 60 seconds, the
display shows “No gas flow...” and aborts the
calibration.

Note: The reading should be very close to the span gas
value. After about 5 seconds pause, the display will
show the message “Span Cal Done! Turn Off Gas.”

. This completes the single gas calibration procedure for
one sensor. The display shows the single gas
calibration sub-menu for a user to select another sensor
or move to the next calibration sub-menu.

. Turn off the flow of gas. Disconnect the calibration
adapter from the Q-RAE Monitor.

. Repeat Step 1 to Step 4 to calibrate the next sensor.

. Press [MODE] any time during Step 2 to reduce waiting
time. If the sensor failed the calibration, the sensor
name and an error message “failed, continue?” will
appear. Press [N/-] or [MODE] to abort the calibration
and move directly to the next sub-menu item. Press
[Y/+] to continue single gas calibration. In either case,
the current calibration data will not be changed.
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Oxygen Sensor Calibration

The oxygen sensor calibration is slightly different from all
other sensors. The oxygen sensor measures a range from 0
to 30% of oxygen in the air. During “fresh” air calibration,
the oxygen sensor is calibrated to a pre-programmed value
of 20.9% by volume oxygen. During single sensor
calibration, the user can supply pure nitrogen gas to
calibrate the oxygen sensor to 0% oxygen. The user can
also supply another span concentration of oxygen, e.g.
19.5%, to calibrate the oxygen sensor. A question “0%
oxygen?” will be asked. Enter [Y/+] if pure nitrogen gas is
used to calibrate the oxygen sensor. Otherwise, press [N/-]
to calibrate oxygen sensor to another span oxygen value.
During either single or multiple sensor calibration, the
oxygen sensor will be calibrated to the span value defined
in Section 4.4.4.

Note: After a “0% oxygen” calibration, the user must
perform a fresh air calibration to ensure that the
oxygen sensor is calibrated correctly.

Calibration Time Stamp

When a single or multiple sensor calibration is performed,
a time stamp will be stored in the non-volatile memory.
This information will be included in the datalogging
report.
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4.4.4 Modify Span Gas Value

This function allows the user to change the span values of
the standard calibration gases.

1. “Modify Span Gas Value?” is the next sub-menu item
in Table 4.3.

2. Press the [Y/+] key. The display shows:

50 25
50 span 20.9

A cursor is blinking at the first digit of the first span
value. If the user wants to modify any one of the span
gas values, go to Step 3. Otherwise, press and hold the
[MODE] key for 1 second to accept the previously
stored span gas value and move to the next calibration
sub-menu.

3. Starting from the left-most digit of the span gas value,
use [Y/+] or [N/-] key to change the digit value and
press [MODE] key momentarily to advance to next
digit, the cursor will move to the next digit to the right.
Repeat this process until all span gas values are
entered. Press and hold the [MODE] for 1 second to
save the new calibration gas value.

4. The display shows “Save?” To confirm the new value,
press the [Y/+] key to accept the change. Press the [N/-]
key or the [MODE] key to discard the change and move
to the next calibration sub-menu.
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445 Change LEL Span Gas

This function allows the user to select a specific LEL gas
to be used as the span gas during LEL gas calibration.

1.

“Change LEL Span Gas?” is the next sub-menu item in
Table 4.3.

Press [Y/+] key. If LEL sensor is installed and enabled,
the display shows:

LEL Span =7?
Methane

Otherwise, the message “No LEL installed will
appear.

If the user does not want to change the LEL span gas,
press [Y/+] to accept the current selection and exit this
sub-menu.

If the user wants to select a different LEL span gas,
press [N/-] key. Then use the [Y/+] and [N/-] keys to
scroll up or down through the list of gas names until the
desired gas appears in the display, and press [MODE]
to select the new gas name.

The display shows “Save?” To confirm the new gas
selection, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and move to the next display.
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4.5 Change Alarm Limits

In the programming mode, the users may change alarm
limits of each sensor for the Q-RAE Monitor. Table 4.4
shows the sub-menus for changing the alarm limits.

Table 4.4

Alarm Limit Sub-Menu
Change High Alarm limit?

Change Low Alarm limit?
Change STEL alarm limit?

Change Average alarm limit?

1. The sub-menu item in Table 4.4 allows the user to
change the high alarm limit, low alarm limit, STEL
alarm limit or average alarm limit. The average alarm
limit can be “Running Average” or “TWA (Time
Weight Average) depending on the menu selection on
“Change Averaging Method” (see Section 4.7.8). Press
[N/-] to cycle through the sub-menu. Press [Y/+] key
to enter a sub-menu and the display shows “HIGH”,
“LOW?”, “STEL”, “TWA” or “AVG” with a flashing
cursor on the left-most digit of the previously stored
alarm limits.

200
20

20 HIGH
23.5
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35
10
10 LOW
19.5
100 15
STEL
35 10
TWA
1.0 10
AVG

2. To modify this limit, starting from the left-most
digit, use the [Y/+] or [N/-] key to change the digit value
and press the [MODE] key momentarily to advance to the
next digit. The flashing digit will move on to the next digit
to its right. Repeat this process until all the new Alarm
limits are entered. Press and hold the [MODE] key for 1
second to exit data entry mode. If there is any change to
the existing value, the display shows “Save?” Press the
[Y/+] key to accept the new value and move to the next
sub-menu. Press the [N/-] key to discard the changes. To
preserve the previously stored alarm limit, press and hold
the [MODE] key for 1 second and the monitor will exit
data entry mode and move to the next sub-menu.
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4.6 View or Change Datalog

Q-RAE monitor calculates and stores the gas readings at a
specified interval. The user can review these stored
readings or change datalog setup from the programming
mode. Users can also program additional datalog options
in PC and downloaded them to the monitor (see Section
5.0 for details on how to program additional datalogging
options). Table 4.5 shows the sub-menus for datalog
options:

Table 4.5
Datalog Sub-Menu

Reset Peak and Minimum?
Clear All Data?

Change Datalog Period?
Select Data Type?

View Datalog?

Enable / Disable Datalog?
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4.6.1 Reset Peak and Minimum

This function will reset peak and minimum data stored in
the non-volatile data memory.

1. “Reset Peak and Minimum?” is the first sub-menu item
in Table 4.5.

2. Press the [Y/+] key to clear the peak and minimum data
memory. Display shows “Are You Sure?” to reconfirm
whether to reset peak and minimum data.

3. Press the [Y/+] key again will reset peak and minimum
data.

4. Press the [N/-] or [MODE] key to exit without resetting
the data and move to next datalog sub-menu.

Note: STEL and TWA (or AVG) value will not be
affected when peak and minimum values are reset.
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4.6.2 Clear All Data

This function erases all data stored in the non-volatile data
memory. It does not change STEL, TWA, Peak, minimum
concentration or run time values which are stored in the
other location.

1. “Clear All Data?” is the next sub-menu item in Table
4.5,

2. Press the [Y/+] key to clear the data memory. Display
shows “Are You Sure?” to re-confirm the clearing of
memory.

3. Press the [Y/+] key again will erase all the data
memory.

4. Press the [N/-] or [MODE] key to exit without clearing
the data memory and move to the next datalog sub-
menu.
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4.6.3 Change Datalog Period

The datalog period can be programmed from 1 to 3,600
seconds (1 hour).

1.

“Change Datalog Period?” is the next sub-menu item in
Table 4.5.

Press the [Y/+] key, the display shows “New Period =
0060 with the left-most digit flashing, where “0060” is
the previously stored data log period.

To modify this period, starting from the left-most digit,
use the [Y/+] or [N/-] key to change the digit value and
press the [MODE] key momentarily to advance to the
next digit. The flashing digit will move to the next
digit to the right. Repeat this process until all 4 digits
of the new period are entered. Press and hold the
[MODE] key for 1 second to exit data entry mode. If
there is any change to the existing value, the display
will show “Save?” Press the [Y/+] key to accept the
new value and exit the datalog sub-menu. Press the
[N/-] key to discard the changes and move to the next
menu option.

To preserve the previously stored period, press and
hold the [MODE] key for 1 second. The monitor will
exit data entry mode and move to the next sub-menu
item in Table 4.5.
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4.6.4 Select Data Type

The user can choose to store either the average or the peak
value during each datalog period.

1.

“Select Data Type?” is the next sub-menu item in Table
4.5.

Press the [Y/+] key, the display shows the current data
type: “Data Type = Average?”

Press the [Y/+] key to accept the currently displayed
data type. Press [N/-] key to change to the other data.
type: “Data Type = Peak?” Press [MODE] key to exit
this sub-menu and move on to the next sub-menu.

If there is any change to the existing selection, press the
[Y/+] key and the display will show “Save?” Then,
press the [Y/+] key again to accept or the [N/-] key to
discard the change and move to the next sub-menu.

Note: It is necessary to select “Average” data type in

order to calculate the correct STEL and TWA
data for the datalogging report (see Section 5.9).



PROGRAMMING

4.6.5 View Datalog

This function allows the user to review all the data that is
stored in the non-volatile data memory.

1. “View Datalog?” is the next sub-menu item in Table
4.5. Press the [Y/+] key and the LCD display shows the
first event number and start date and time of the event.

Event # 1?
8/3/96 8:20

2. Press [Y/+] to review data of the first event. The
display shows the stored data of each sensor and the
time stamp:

1 0

2 8:20
20.5

3. Press the [Y/+] or [N/-] key to move forward or
backward and view other data in this event. When
reaching the end or the beginning of the event, the
message “Start of data!” or “End of data!” appears.
Press [MODE] to exit the current event.

4. Press [N/-] at Step 2 to see next event. If there are no
more events, the message “No more event! Quit?” will
appear. Press [N/-] to go back to the first event or
[Y/+] to exit and move to the next sub-menu.
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4.6.6 Enable/ Disable Datalog

The user can choose to enable or disable the datalogging
function on each individual sensor. This allows users to
selectively log certain sensor readings of interest.

1.

“Enable / Disable Datalog?” is the next sub-menu item
in Table 4.5.

Press [Y/+] key. The display shows all the installed
sensors in the monitor. A previously selected sensor to
be datalogged is marked with an “*” next to the sensor
name. The cursor is blinking at the first sensor
location. Press [Y/+] to enable the datalogging for the
sensor and [N/-] to disable the datalogging.

CO* H,S*
LEL pick OXY

Press the [MODE] key momentarily to move from one
sensor location to the next one. Repeat Step 2 until all
the sensors that need to be datalogged are selected.
Press and hold [MODE] for 1 second to save the new
sensor selection.

The display shows “Save?” To confirm the new
selection, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and return to the first datalog sub-menu.
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4.7 Change Monitor Setup

In the programming mode, users may change monitor
setup or enter user information for the Q-RAE monitor.
Table 4.6 shows the sub-menus for changing the monitor.

Table 4.6
Monitor Setup Sub-Menu
Change Site ID?

Change User ID?

Change Alarm Mode?
Change User Mode?
Change Real Time Clock?
Change Backlight Mode?
Change Password?

Change Pump Speed?

Change Averaging Method?
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4.7.1 Change Site ID

The user can enter an 8 digit alphanumeric site ID in the
programming mode. This site ID will be included in the
datalog report.

1.

“Change Site ID?” and “Change User ID?” are the first
and second sub-menu item in Table 4.6.

Press [MODE] key to choose one of them and press the
[Y/+] key, the display shows the current site ID: “Site
ID = xxxxxxxx” or the current user ID: “User ID =
XXXXXXXX” with the left most digit flashing.

Press the [Y/+] or [N/-] key to cycle through all 26
letters and 10 numerals. Press [MODE] key
momentarily to advance to the next digit. The flashing
digit will move to the next digit to the right. Repeat
this process until all 8 digits of the new site ID are
entered.

Press and hold the [MODE] key for 1 second to exit
the data entry mode and move to the next monitor setup
sub-menu.

If there is any change to the existing site ID, the display
shows “Save?” Press the [Y/+] key to accept the new
site ID and exit the monitor setup sub-menu. Press the
[N/-] key to discard the changes and move to the next
sub-menu.
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4.7.2 Change Alarm Mode

There are two different alarm modes: latched and
automatic reset in Q-RAE that can be selected from the
programming menu.

1.

“Change Alarm Mode?” is the third sub-menu item in
Table 4.6.

Press the [Y/+] key, the display shows the current alarm
mode selection: “Alarm Mode = Latched?”

Press the [Y/+] key to accept the currently displayed
alarm mode. Press [N/-] key to change to the other
alarm mode: “Alarm Mode = Auto Reset?” Press
[MODE] key to exit this sub-menu and move to the
next monitor setup sub-menu.

If there is any change to the existing selection, pressing
the [y/+] key the display will show “Save?” Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the next sub-menu.
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4.7.3 Change User Mode

There are three different user modes: text, display and
programming in Q-RAE that can be selected from the
programming menu.

1.

“Change User Mode?” is the fourth sub-menu item in
Table 4.6.

Press the [Y/+] key, the display shows the current user
mode selection: “User Mode = Program?”

Press the [Y/+] key to accept the currently displayed
user mode. Press [N/-] key to scroll through the other
two user modes. Press [MODE] key to exit this sub-
menu and move to the next monitor setup sub-menu.

If there is any change to the existing selection, pressing
the [y/+] key the display will show “Disable Program!
Are you Sure?” Then, press the [Y/+] key to accept or
the [N/-] key to discard and move to the next sub-menu.

NOTE: If the user mode is changed to display or text
mode, the user can no longer enter the programming menu.
Therefore, the user cannot change the user mode back to
program mode from the monitor. The only way to
change the user mode back to “program’” mode is to
use a PC and the ProRAE-Suite program or “multicfg”
program (see Section 5 for details).
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4.7.4 Change Real Time Clock

The Q-RAE monitor is equipped with a real time clock.
The user can enter the correct date and time into the real
time clock in the programming mode.

1. The fifth sub-menu item in Table 4.6 is “Change Real
Time Clock?”

2. Press [Y/+] key, the display shows both the current date
and time: “Date = mm / dd” and “Time = hh: mm”
with the left most digit of the date flashing.

3. To modify this value, use the [Y/+] or [N/-] key to
change the digit value and press the [MODE] key
momentarily to advance to the next digit. The flashing
digit will move on to next digit to its right. Repeat this
process until the new date and time values are entered.
Press and hold the [MODE] key for 1 second to exit
data entry mode. If there is any change to the existing
value, the display shows “Save?” Press the [Y/+] key to
accept the new value and move to next sub-menu.
Press the [N/-] key to discard the changes and move to
next sub-menu.
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4.7.5 Change Backlight Mode

The Q-RAE monitor allows a user to choose to turn on and
off LCD backlight automatically when ambient light falls
bellow or above a threshold level or to turn on and off the
back light manually by pressing the [N/-] key.

1. The sixth sub-menu item in Table 4.6 is “Change
Backlight Mode?”

2. Press [Y/+] key, the display shows the current back
light mode: “Backlight Mode = manual turn on?”.

3. Press the [Y/+] key to accept the currently displayed
backlight mode. Press [N/-] key to change to the other
backlight mode: “Backlight Mode = manual turn on?”
Press [MODE] key to exit this sub-menu and move to
the first monitor setup sub-menu.

4. If there is any change to the existing selection, pressing
the [Y/+] key the display will show “Save?” Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the next sub-menu.
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4.7.6 Change Password

The user can modify the password from the monitor.

1.

2.

The seventh sub-menu item in Table 4.6 is “Change
Password?”

Press the [Y/+] key and the display shows the current
password: “Enter new password = xxxx” with the left
most digit flashing.

Press the [Y/+] or [N/-] key to cycle through all 10
numerals. Press [MODE] key momentarily to advance
to the next digit. The flashing digit will move to the
next digit to the right. Repeat this process until all 4
digits of the new password are entered.

Press and hold the [MODE] key for 1 second to exit
the data entry mode and move to the next monitor setup
sub-menu.

If there is any change to the existing password, the
display shows “Save?” Press the [Y/+] key to accept
the new password. Press the [N/-] key to discard the
changes and move to the next sub-menu.

The monitor next asks for this value to be confirmed.
“Confirm New Password = 0000” with the left most
digit flashing. The number must be reentered, as
before, to exit the monitor setup sub-menu. If
misentered the second time, the password reverts to its
original setting.
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4.7.7 Change Pump Speed

There are two speed settings for the pump motor in the Q-
RAEthat can be selected from the programming menu:
low (default) and high. The “high” setting should be
used for long lengths of tubing or when rapid changes in
input conditions are expected. “Low” may be selected
when the operating conditions are slow to change. Low
may also be used to prolong pump motor life; LEL sensor
life and battery run time.

1. “Change Pump Motor Speed?” is the eighth sub-menu
item in Table 4.6.

2. Press the [Y/+] key, the display shows the current pump
speed selection: “Pump Speed = Low?”

3. Press the [Y/+] key to accept the currently displayed
pump speed and move to the next monitor setup sub-
menu. Press [N/-] key to change to the other speed
“Pump Speed = High?” Press [MODE] key to exit this
sub-menu and move to the next monitor setup sub-
menu.
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4.7.8 Change Averaging Method

There are two methods of calculation used in the averaging
of the monitor. Using this selection can cause the
calculation to be performed using an eight-hour time
weighted average (TWA), the default, or a running average
(AVG). The display indicator for whichever averaging
type is selected will show on the LCD display wherever
the average is indicated.

1.

“Change Averaging Method?” is the ninth sub-menu
item in Table 4.6.

Press the [Y/+] key, the display shows the current
average selection: “Average Type = TWA?”

Press the [Y/+] key to accept the currently displayed
type. Press [N/-] key to change to the other selection:
“Average Type = Running Average?”, and [Y/+] to
select.

If there is any change to the existing selection, pressing
the [Y/+] key, the display will show “Save?” Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the first setup sub-menu.
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4.8 Change Sensor Configuration

In the programming mode, users may change several

sensor-related configurations of the Q-RAEmonitor.
Table 4.7 shows the sub-menus for setting various
configurations of the sensors.

Table 4.7
Sensor Configuration Sub-Menu

Change LEL Gas Selection?
Enable / Disable Sensors?

Change Dilution Ratio?

Before these sub-menus are described, the term
“Correction Factor” needs to be explained:

Correction Factor

The LEL sensors used in Q-RAE respond to a broad range
of gases that have different sensitivities. The correction
factor for a specific gas is defined as:

Sensitivity to a calibration gas

Correction Factor = — —
Sensitivity to a specific gas

Correction factors are often used to obtain calculated
concentrations of a specific gas while using a different gas
during calibration (typically methane or pentane).

The Q-RAE monitor stores a set of the correction factors
for the LEL sensor. The set consists of 20 to 40 different

4 - 36
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gases. The user can choose one gas from the list to be the
calibration gas and another gas to be the measurement gas.

For example, the user can choose methane as the
calibration gas for the LEL sensor and select pentane as the
measurement gas. The Q-RAE monitor will calculate the
correction factor between these two gases and convert the
measured value of the LEL sensor into equivalent
concentration of the pentane gas.
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4.8.1 Change LEL Gas Selection

This function allows users to choose one of the pre-stored
LEL gases in the monitor and calculate its correction factor
relative to the LEL calibration gas. This factor will then be
used during gas measurements to show the equivalent
concentration of the selected LEL gas. The user can also
modify this relative correction factor to increase or
decrease the gas reading. This allows users to create a
custom factor for a specific gas or mixture of gases.

1.

“Change LEL Gas Selection?” is the first sub-menu
item in Table 4.7.

Press [Y/+] key. If an LEL sensor is installed and
enabled, the display shows:

LEL Gas =?
Methane

Otherwise, the message “No LEL installed” will be
displayed and skip to Step 8.

If the user does not want to change the LEL
measurement gas, press [Y/+] key to accept the current
gas and skip to Step 6.

If the user wants to modify the LEL measurement gas,
press [N/-] key first, then use [Y/+] or [N/-] key to
scroll through a list of gas names until the desired gas
name appears in the LCD display, then press [MODE]
key to select the new gas name.
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5. The display shows “Save new gas?” To confirm the
new gas, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and move to the next step.

6. Display shows

Methane
LEL Factor = 1.00?

where “1.00” is the calculated correction factor of the
selected gas in Step 4.

7. If the user does not want to modify the LEL correction
factor, press [Y/+] key and go to Step 8. To modify
this factor, press [N/-] key first. Then starting from the
left-most digit, use the [Y/+] or [N/-] key to change the
digit value and press the [MODE] key momentarily to
advance to the next digit. The flashing digit will move
on to next digit to its right. Repeat this process until all
4 digits of the new factor are entered. Press and hold
the [MODE] key for 1 second to exit data entry mode.
If there is any change to the existing value, the display
shows “Save?” Press the [Y/+] key to accept the new
value and exit the gas selection sub-menu. Press the
[N/-] key to discard the changes.
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4.8.2 Enable/Disable Sensor

This function allows the user to selectively enable or
disable individual sensors in the Q-RAE monitor. When a
sensor is disabled, the sensor will not measure nor display
the gas concentration.

1.

“Enable / Disable Sensors?” is the next sub-menu item
in Table 4.7.

Press [Y/+] key. The display shows all the installed
sensors in the monitor. A previously enabled sensor is
marked by an “*** next to the sensor name. The cursor
will blink at the first sensor location. Press [Y/+] key to
enable the sensor and [N/-] key to disable the sensor. A
previously disabled sensor will show *“----" instead of
the sensor name.

CO* H,S*
LEL* pick  OXY*

Press [MODE] key momentarily to move from one
sensor location to the next one. Repeat Step 2 until all
the sensors that need to be enabled are selected. Press
and hold [MODE] key for 1 second to save the new
sensor selection.

The display shows “Save?” To confirm the new
selection, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and move to the next sub-menu.
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4.8.3 Change Dilution Ratio

An optional dilution fitting can be inserted on the gas inlet
port of the MultiRAE PLUS to dilute the gas sample. The
dilution ratio (from 1 to 10) can be entered so that the
reading is compensated to show the actual concentration of
the gas sample before dilution.

1.

“Change Dilution Ratio?” is the next sub-menu item in
Table 4.7.

Press the [Y/+] key, and the display shows the current
dilution ratio: “Dilution Ratio = xx” with the left most
digit flashing.

Press the [Y/+] or [N/-] key to increase or decrease the
value of the digit. Press [MODE] momentarily to
advance to the next digit. The flashing digit will move
to the next digit to the right. Repeat this process until
both digits of the new dilution ratio are entered.

Press and hold the [MODE] key for 1 second to exit the
data entry mode and move to the next sub-menu.

If there is any change to the existing dilution ratio, the
display shows “Save?” Press [Y/+] to accept the new
ratio and exit the sub-menu. Press [N/-] to discard the
changes and move to the next sub-menu.
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Exit Programming Mode

1.

To exit programming mode from the first tier menu
level (see Table 4.1), press the [MODE] key once.
Display shows an instantaneous reading of normal
operation mode.

To exit programming mode from 2nd tier sub-menu
level (see Table 4.2 - 4.6), press the [MODE] key twice.

To return to programming mode, press and hold down
both the [MODE] and [N/-] keys for 3 seconds as
described in Section 4.4.
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5. COMPUTER INTERFACE FOR Q-RAE

Each Q-RAE has datalogging capability and is shipped
with a software package, called ProRAE-Suite, and a serial
computer interface cable.

This software package runs on any IBM compatible
Personal Computer (PC) under Windows 95®, Windows®
98, Windows NT® 4.0, Windows ME and later
environments. It allows the user to configure the Q-RAE
through a user-friendly interface and send the
configuration information from the PC to the Q-RAE
monitor. Collected data can also be extracted from the Q-
RAE to the PC in order to perform data analysis, report
generation or record keeping. Installation and operation of
this software package is described in the following
sections.
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5.1 Install ProRAE-Suite Software

ProRAE-Suite software package is supplied with the Q-
RAE datalogging monitor. This software package is
available on three 3.5” setup diskettes. To install the
ProRAE-Suite software, insert the first setup diskette into
the “A” or “B” floppy disk drive. Click the Start button
on the taskbar to display the start menu, then click the Run
from the start menu to display the Run dialog box. If the
setup diskette is in disk drive A, type A:\Setup.exe in the
Open field, as shown in Figure 5-1.

Run |

Type the name of a program, folder. or document, and
"Windows will open it for you,

Open; I.ﬁ.:setud j

| k. I Cancel | Browsze. .. |

Figure 5-1 Run Dialog Box

Press the Enter key on the keyboard or click the OK button
on the menu to start the setup process. If the user choose
the default settings in every steps of the process, the
ProRAE-Suite software package will be installed under the
default directory: C:\Program FilesS\RAE Systems
Inc\ProRAE-Suite. After the software is installed
successfully, a new menu item ProRAE-Suite is added to

5-2
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the Programs menu. To start the ProRAE-Suite software,
click the Start button on the taskbar to display the Start
menu, click the Programs menu item to display the
Programs submenu, then click the ProRAE-Suite menu
item to display the ProRAE-Suite submenu. There are

two sub-menu items under the ProRAE-Suite submenu:
ProRAE-Suite and Readme, as shown in Figure 5-2.
Click the ProRAE-Suite sub-menu
ProRAE-Suite software.

item to start the

MNew Office Documnent
—

Open Office Document

3Com MIC Utilities
Accessolies
Compaq Utilities
Graphics Server 5

HiJaak 95

lomega Tools

Lotus Applications

I ain

MFC Samples on COROM

Diocuments

Settings

MFC Template

[ Microsoft ODEC

* [ Microsoft Reference

[ Microsoft Visual C++

[ Microsoft Visual C++ 5.0

* [B) Microsoft wWorks for Windows
[3 0dbe

Onling Services

ProRAE -Suite

g merECk

Shut Dawn

R apidComm Voice
Startlp

@ Explaring - [C:]

| L1.5. Robotics Connections

* v vRE v v v v v v ¥ ¥ v ¥ v w¥v v v ¥ v ¥

@ Internet Explorer
% Imternet Mail
&5 Internet News
% Microsoft Access

% Microsoft Binder

A% Microsoft Excel

i Microsoft Methesting
B9 Microsoft Outlook
Microzoft PowerPoint
W Microsoft ‘Word

BE 15005 Frompt

The Microsoft Metwork.
@ ‘windows Explorer

@ ‘windows Meszaging

% ProRAE-Suite

Figure 5-2 Start Menu
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5.2 Connect Q-RAE to PC

The basic kit of a Q-RAE datalogging monitor includes a
serial interface cable. Connect the DB-9 connector side of
the cable to the serial port of the PC, and connect another
side of the cable to the Q-RAE monitor.

Turn on the power to the Q-RAE monitor. Press the
[MODE] key several times until the LCD shows
“Communicate with PC?” Press the [Y/+] key and the
display shows “Monitor will Pause, OK?” Press [Y/+] key
to confirm and the display shows “Ready...” to indicate
that the Q-RAE monitor is ready for communication with
PC. During the communication session, the PC will
directly control the Q-RAE monitor through the serial link.
There is no need for users to press any key on the Q-RAE
monitor during the communication session.

If no data transfer has occurred within one minute, the Q-
RAE monitor will return to instantaneous reading display.

Note: Do not connect to the parallel port of the PC by
mistake. The parallel port is usually a 25 pin female D
connector on the back of the PC, the serial port is usually
a 25 or 9 pin male D connector. If the serial port on the
PC is a 25 pin connector, the user needs to use a 25 pin to
9 pin adapter in order to accept the serial cable.
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5.3 Start ProRAE-Suite Software

To start the ProRAE-Suite software, click the Start button
on the taskbar to display the Start menu, click Programs -
> ProRAE-Suite -> ProRAE-Suite submenu item to start
the ProRAE-Suite software. Figure 5-3 shows the main
window of the ProRAE-Suite software.

Figure 5-3 ProRAE-Suite Main Window

The functions of ProRAE-Suite software can be divided

into three categories:

1) Configuration data category. This category includes
editing the configuration data file, sending the
configuration data to the Q-RAE monitor and receiving
the configuration data from the Q-RAE monitor, etc..

2) Logged data category. This category includes
receiving the logged data from the Q-RAE monitor,
displaying the logged data in different format,
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exporting the logged data to a tab delimited text file so
that it can be read by the Microsoft Excel software, etc..
3) Upgrade category. This category includes upgrading
the datalog feature of the Q-RAE monitor, and
upgrading the firmware in the Q-RAE monitor.

There is a tool bar beneath the menu bar. The frequently
used functions are represented in this tool bar in the form
of a small icon. For example, the Receive data function in
the Communication sub-menu is represented as a small
arrow with the letters “RECV.” When the mouse cursor (a
small arrow) is positioned near each icon in the tool bar, a
short text will also appear at the bottom of the Window to
describe the function of this icon.

This tool bar allows users to invoke a function
conveniently by clicking on the icon without going
through the sub-menus.
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5.4 Setup Communication Port

It is necessary to setup the communication port on the
ProRAE-Suite software so that the Q-RAE monitor can
communicate with the PC correctly. Figure 5-4 shows the
Setup Port dialog box. Choose the appropriate port
according to the PC’s serial port setup.

R~

|’F'Iea$e zelect the zenal part

& COWi ¢ coM2z € COM3 € COM4

ol _|

Figure 5-4 Setup Port Dialog

Note: In most PC's, there are two serial ports. Make sure
that the serial port selected in the Setup Port dialog box
matches the actual serial port connected to the Q-RAE
monitor. The default serial port for ProRAE-Suite is
COML. If the incorrect serial port is selected, an error
message of “error occur during serial port initialization”
will appear when a user tries to communicate between the
PC and the Q-RAE monitor.
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5.5 Processing the Configuration Data

The ProRAE-Suite software allows the user to edit the
configuration data, send the configuration data to the Q-
RAE, and receive the configuration data from the Q-RAE
monitor. The following subsections describe the details of
each operation.
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5.5.1 Editing the Configuration Data

There are two different sources of the configuration files.
One is loaded from the unit; the other is from a
configuration file stored on a PC.

To load and review the configuration of the monitor: From
the main menu of the ProRAE-Suite software, select the
Receive Configuration... menu item from the
Communication dropdown menu, and then click the OK
if the unit is connected to the communication port and
ready.

To load a saved configuration file: From the main menu,
select Open from the File... dropdown menu, a dialog box
appears. Select the “Files of type:” to Config Files [*.cfg],
as shown in Figure 5-5.

EREr - ||= =

] Defaull_MuliRAE_W216.cfg ] Defaull YRAE7S00_%109.cfg
Default_ppbRAE_W101.cfg Default_VRAETI00 V110.cfg
Defaull_ORAE_W220.cfg Default_WRAETS40_109.cfg
Default_ToxiBAE_W1 22.::% Default_YRAETS40 V110.cfg
Default_UlraRaE 224 cfg test temp.cfg
Default_UlraRaE % 230.cfg

Config Files [*.cfg) =]

Figure 5-5 Open Dialog Box
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There should be one or more configuration files in the file
list. Each configuration file has a file extension of “.CFG”.
There is one generic Q-RAE configuration supplied with
ProRAE-Suite software: Default Q-RAE_V###.CFG,
where ### is the version number of the default
configuration file. For example, Default_Q-
RAE_V216.cfg means this file is for Q-RAE monitor and
its version is V2.16. Choose a configuration file by
highlighting the file name and press the Enter key or click
the OK button on the dialog box.

Once the configuration file is open, the configuration data
are displayed in the newly opened client window, as shown
in Figure 5-6.

« ProRAE-Suite - Default ORAE V220.cig

=H8| sl= ElE] <[2] 2]
B2 Default_ORAE_V220.cfg
Instrument: [)-RAE Serial Number: 000000 [=]

Firmware Yersion: 2.20
Datalog: Enabled

General:

Site ID: 00000001 User ID: 00000001

Security Level: Level 2 — no password needed
User Mode: Program

Warm-up Time: 10 sec. I
Comfort Beep: Disabled

Back Light: Manual

Back Light Time Out Period: 60 sec.

Figure 5-6 Displayed Configuration Data

To edit the opened configuration data file, click the Edit ->
Configuration menu item or the Configuration toolbar
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button to open the Edit Configuration File dialog box, as
shown in Figure 5-7.

Edit Configuration File

Figure 5-7 Edit Configuration File Dialog Box

The Edit Configuration File dialog box contains four tab
pages: General, Gas Parameters, Gas Selection and
Others. To change a specific configuration setting, click
the corresponding tab page header to bring that tab page to
the front, then change the configuration setting on that tab
page. When finished editing the configuration settings,
click the OK button to close the Edit Configuration File
dialog box. The new values of the configuration settings
will be reflected in the client window.



COMPUTER INTERFACE

The General tab page, which is shown in Figure 5-7,
allows a user to change the general settings of the
configuration data. The following is the description of
each field in the General tab page of the Edit
Configuration File dialog:

ID:

This section sets the identification that is used throughout
the datalog process. Both editing fields, Site and User, can
hold up to eight alphanumeric letters.

Security Level:

There are three levels of security. They are used to
provide protection against unauthorized changes to
monitor settings that can be changed by using the
programming menu of the Q-RAE monitor when the
instrument is in the programming mode.

Level 0 allows a user to enter the programming menu
without password checking, but does not allow changes to
alarm limits, real time clock, correction factor, or user and
site information, etc. The user can still perform
calibrations.

If Level 1 is selected, a four-digit password is required to
enter the programming menu.

If Level 2 is selected, the programming menu may be
entered without restriction. Any changes made in the
programming menu can be saved.

Password:
The four-digit password must be entered if level 1 is
selected as the security level or the monitor is in the Text

5-12



COMPUTER INTERFACE

mode. Entry to the programming menu requires that this
password be entered.

User mode:

In the Text mode, the monitor only displays the sensor
name and an OK message during normal operation. In the
Display mode, the user can view several readings in the
normal operation, but cannot enter the programming menu.
In the Program mode, the user can enter the programming
mode to calibrate the monitor or change various setups in
the monitor.

Warm-up Time:
This option allows the user to choose the warm-up time of
the instrument, in seconds.

Comfort Beep:

This option allows the user to specify a time interval that
the buzzer will beep once to remind the user that the
monitor is on. If zero is entered for the time interval, then
the security beep feature is disabled.
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Backlight:

This option allows the user to choose to turn on and off the
LCD back light manually or automatically based on the
ambient light sensor input. If Manual mode is selected,
the user can also enter a time out period so that the back
light will be turned off automatically after the time out
period. If Auto is selected, the ambient light sensor will
automatically turn on and off the backlight.

Clock from PC:

This option allows the PC clock to be downloaded to the
Q-RAE monitor so that the user does not need to manually
set the clock in the Q-RAE monitor.

Pump Speed:
This option allows the user to choose the high pump speed
or low pump speed for the Q-RAE monitor.

Measure:
The user can choose to record the average or peak (Max)
reading of all the sensors during each datalog period.

Datalog Interval:

The datalog interval is the rate at which datalog samples
are recorded while the datalog is running. The unit of
datalog interval is second. The datalog interval determines
how often a new sample is calculated and stored to the
datalog. The unit of a datalog interval is one second.
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Datalog Selection:

The user can choose one or more sensors for datalogging
purpose. This does not activate or inactivate the particular
sensor’s readings except for the purpose of datalogging
recording.

Datalog Mode:

This may be set to either of four choices:

-- With Automatic start/stop, the datalogging begins
when the monitor is turned on and ends when it is turned
off.

-- With Manual start/stop, the datalog can begin by a
series of key presses in the menu of normal operation. The
maximum run time determines an automatic end to the
datalog or it can be stopped manually.

-- If Periodic start /stop (or daily) mode is chosen, the
user must specify the start and stop hour and minute. The
interval between start and stop is the period of time the
monitor will datalog (at “data logging period” rate).

-- With Scheduled start/stop, all the entry boxes for year,
month, day, hour and minute for both start and stop time
must be entered to specify when the datalog is to occur.

Run Time:

If manual start/stop mode for datalogging is chosen, the
user needs to specify a maximum run time. After the
monitor has been on for the specified run time, datalogging
will be turned off automatically.
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Start Time and Stop Time:

If scheduled start/stop mode is chosen for datalogging, all
entry boxes must be completed for start and stop year,
month, day, hour and minute. The monitor must already
be turned on. Then once the start date/time is reached, the
monitor will start datalogging. When the stop date/time is
reached, the datalogging will stop automatically. With
periodic start/stop mode, the hours and minutes are used
for the data log period to be run each day.

Figure 5-8 shows the Gas Parameters tab page which
allows the user to change the gas parameters of the
configuration data. The following is the description of each
field in the Gas Parameters tab page of the Edit
Configuration File dialog:

Edit Configuration File

L

{ {

{ 5 { 5 {

ok ] coe |

Figure 5-8 Gas Parameters Settings Tab Page
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LEL Alarm Levels (%):
Here the specify the low and high alarm levels (%LEL)
can be specified for the LEL sensor.

OXY Alarm Levels (%0):
Here the specify the low and high alarm levels (% by
Volume) can be specified for the OXY sensor.

H,S Alarm Levels (ppm):
Here the STEL, TWA, low alarm and high alarm levels
(ppm) can be specified for the H,S sensor.

CO Alarm Levels (ppm):

This is the place where the user can specify the STEL
alarm level (ppm), TWA alarm level (ppm), low alarm
level (ppm) and high alarm level (ppm) for the CO sensor.

Alarm mode:

If Auto reset is chosen, the alarm will stop as soon as the
alarm condition goes away. The alarm will remain on if
the Latched option is chosen. To turn off a latched alarm,
press [Y/+] to acknowledge the alarm condition.
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Power On Zero:

This option allows the monitor to perform a fresh air
calibration automatically when the monitor is turned on.
Care must be taken, when using this mode, to ensure that
the monitor is in a fresh air environment when turned on.

Calibration span:
The user can specify the calibration gas span for LEL,
OXY, H,S, and CO sensors here.

Edit Configuration File

| | TR

Figure 5-9 Gas Selection Settings Tab Page

Figure 5-9 shows the Gas Selection tab page. There are
three sets of gases for correction factors that the user can
choose for the LEL sensor. The following is the
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description of each field in the Gas Selection tab page of
the Edit Configuration File dialog box:

LEL Current Gas selection:

Here the user can choose one gas from the Calibration
Gas list box for calibration and another gas from the
Measurement Gas list box for measurement. Scroll the
list using the up or down arrow until the desired gas name
Is shown. Press Enter to select the gas. The user can also
enter a custom gas name (up to 16 characters long) and a
custom correction factor. If the measurement and
calibration gases are different, the monitor automatically
calculates a correction factor and applies it to the readings
to give a proper %LEL value for the measurement gas.

In the Others tab, the user can put in a power-on
customized name. The name will be displayed when the
unit is powered on. The user can also choose the
supporting of the printer option.

OK / Cancel:

When the configuration changes are completed, click on
the OK button to save the configuration and return to the
client window. Click on Cancel button to abort the
configuration changes.
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5.5.2 Send Configuration to Q-RAE

After the configuration data is loaded into the ProRAE-
Suite software, the user can send the configuration settings
to the Q-RAE monitor. To send the configuration settings
to the instrument, click Communication->Send Config
menu item or click the send toolbar icon (right arrow with
“Send” letters), a message box will appear to remind the
user to connect the instrument to the PC through the serial
port. After making sure that the instrument is connected to
the PC, click the OK button to start the data transfer.

After the configuration information is sent successfully, a
message box will appear to indicate that the sending
configuration process is completed. Click the OK button
to close the message box.

If the communication is not successful, an error message
indicating that there is no response from the instrument
will appear. Check the cable to make sure that the
connectors on both ends of the cable are securely seated in
the sockets. Try to send the information again. If the error
message still appears after repeated attempts, call an
authorized service center for help.
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5.5.3 Saving Configuration Data

In order to save the configuration information for future
use, user can click File->Save or File->Save As menu item
to save the opened configuration data to a file. Once the
configuration file is saved on disk, it can be opened at a
later time for further modification or can be sent to the Q-
RAE monitor.
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5.5.4 Configuring All Settings

A user can use this function to update the entire
configuration settings (except the instrument ID, serial
number and the datalog option) in the Q-RAE monitor. To
configure all the settings in the instrument, click the
Option->Config All menu item and a message box will
appear to remind the user to connect the instrument to the
PC through the serial port. After making sure that the
instrument is connected to the PC, click the OK button.
Another message box will appear to warn the user that this
operation will erase all the current configuration settings in
the monitor. If the user does not want this to happen, click
the Cancel button, otherwise click the OK button to start
the data transfer.

After the information is sent successfully, a message box
will appear to indicate that the sending configuration
process is completed. Click the OK button to close the
message box.

5.6 Warning: The Config All option is
mainly used to restore the Q-RAE
monitor’s default operational settings
when the configuration of the unit is
non-recoverable and the unit is
malfunctioning. Because the default
parameters are not normally fit a
specific unit, a user will need to re-
calibration, re-setup lamp, pump, and
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LCD contrast threshold, etc. Try not to
use this function if possible.
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5.6 Processing the Logged Data

The ProRAE-Suite software allows the user to retrieve the
logged data from the Q-RAE monitor and display the data
in many different formats. The user can also export the
displayed text to a tab delimited text file so that Microsoft
Excel can read it directly.
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5.6.1 Receive Data from Q-RAE

To receive the logged data from the Q-RAE, click
Communication->Receive Data menu item or click the
Receive Data toolbar button (left arrow with “Recv”
letters), a message box will appear to remind the user to
connect the instrument to the PC through the serial port.
After making sure the instrument is connected to the PC,
click the OK button to start the data transfer. After the
data transfer is finished, a new client window is opened
with the newly received logged data displayed. In order to
save the logged data for future use, the user can click File-
>Save or File->Save As menu item to save the newly
received logged data to a file.
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5.6.2 View Logged Data in Text Mode

Once the user opened a data file or received the logged
data from the instrument, a data window appears, as shown
in Figure 5-10.

« ProRAE-Suite - [Timing 503251_dat [ 0-RAE]

E--G-RAE Instrument . Q-RAE
= Data U=zer ID: 00000001

E| Teuxt Mode

Data Point=: 2
La=st Calibration Time:

Eent 82 a1 0531 EE ;
- Event #3 at 05/10/1999 09:39 High Alarn Levels:
L L Event #4 at 05/10/1999 0%:39 Lov alsrm Levels:
- raph Mode
- Ewent #1 at 05/10/1999 09:38
- Ewent #2 at 05/10/1999 09:3 05101999 0938
- Ewent #3 at 05/10/1999 09:3 05101333 09:38
-~ Evert #4 at 05/10/1999 09:3
B STEL/TWA/MYG
P e Event #1 at 05/10/1999 09:38

Figure 5-10 Display Logged Data

The data window is a two-pane client window. The left
pane is a tree view which lists all the display format of
each event, and the right pane displays the information
according to the display format and the event the user
selected on the left pane. To select any display format of
any event, the user can simply click the format item on the
left pane. To view the next event or the previous event, the
user can click the Next Event (double right arrow) or the
Previous Event (double left arrow) toolbar buttons. The
user can also drag the splitter bar between the left pane and
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the right pane to the left or to the right to enlarge a pane if
that pane is not big enough.

To view the data points of a specific event, the user can
click the item representing that event under the item
Data\Text Mode. For example, click the item Event #1
on the left pane, the right pane displays the data points of
event #1, as shown in Figure 5-10.
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5.6.3 View STEL/TWA/AVG Value

To view the STEL, TWA or AVG value of any event, click
the event number item under the tree item
STEL/TWA/AVG in the left pane, the right pane displays
the STEL, TWA and AVG value of each data points of that
event, as shown in Figure 5-11.

« ProRAE-Suite - [Timing 503251.dat [ O-RAE ]

Instrunent . O-RAE
... Ewent #2 at D5A10/1993 0% W= g0 Uil
| e Event 4 at 05/10/1999 0338
- Graph Mode
- Ewent #1 at 0541041999 09:38 flarm Typs:
. Event #2 at 05/10/1593 05 38 Alarm Levels:
- Ewent #3 at 05/10/1993 0938
- Ewent B4 at 05/10/1993 0938

= STEL/TWih sl G 0c-10.,1999 0915
EC o021 At 05/10/1999 09358 <10~ i
[ E wvent #1 at 05/10/1959 0938 05-10-1999 09328

Ewvent #2 at 05/10/1933 09:22 %
Ewvent #32 at 05/10/1933 09:22
“ Event H4 at 05/10/1999 09.38

Figure 5-11 STEL/TWAJ/AVG of the Logged Data
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5.6.4 View Summary Information

To view the summary information of any event, such as
peak data value and minimum data value, click the event
number item under the tree item Summary in the left pane,
the right pane displays the summary information of that
event, as shown in Figure 5-12.

« ProRAE-5Suite - [Timing 503251.dat [ O-RAE ]

i Event #1 at 05/10/1399 09.38
Event #2 at 05/10/1933 03:
Ewvent #3 at 05/10/1933 03:
Ewvent #4 at 05/10/1993 03;
E- STEL/Twa/aWG

Instrument: (Q-RAE

User ID: 00000001 Site ID:
Data Points: 2 Data Type
Last Calibration Time: 04-28-1999 10:(
Start At: 05-10-1999 09:38 End At: 0

- Event #1 at 05/10,/1999 09:38 genﬁﬂii Ievel co 5 E‘E‘m% 02 5936) c
- 149. aXm evels! 5 .
Event #2 at 05/10/1999 053:38 I e it =N N

- Event #3 at 05/10/1933 03:38
- Event #4 at 05/10/1999 09,38
=~ Summary

=Ecent #1 at 05/10/1993 0938
- Event #2 at 05/10/1933 09. 38 %
- Event #3 at 05/10/1933 03:38
- Event 14 at 05/10,/1399 0338

STEL Alarm Lewvels: 1a0.0
TWA Alarm Levels:

Sen=or: CO{ppm) 02{%)

Peal: Data Value: 37.2 20.9
Min Data Valus: 36.9 20.9
TWA Data Valus:
AVG Data Value:

Figure 5-12 Summary Information of the Logged Data |
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5.6.5 View Logged Data in Graph Mode

To view the logged data of a specific event in graph mode,
click the event item under the tree item Graph Mode in the
left pane, and the right pane displays the graph of that
event, as shown in Figure 5-13.

%= ProRAE-Suite - [Timing 503251.dat [ -RAE ]

- Tent Mode

i - Event #1 at 05,104
¢ e Event 82 at 0541041
- Event #3 at 0510419
- Event 4 at 0510419
- Graph Mode
- Event #1 at 05410419
- Event #2 at 0510419
- Event #3 at 05/10/19
EE vent Hd at 05/10/1
E- STEL/Twa/aWG

Gas
Concentration

s 4 CCdppm]
)
.+ HES{ppm)

1004 4 LEL%)

] + + + 1 1
0510098 0510 033 0510 09:50
ey e =T S fad 08T

Date Time (1999)

Figure 5-13 Graph of the Logged Data

Select graph type:

The user can choose the type of sensor data in the Graph
Type tab page of the Graph Settings dialog box. To
display the Graph Settings dialog box, click any place in
the right pane so that pane has the focus, then click
Option->Graph Settings menu item to display the Graph
Settings dialog box. Figure 5-14 shows the Graph Type
tab page of the Graph Settings dialog box. This is the
place where the user can choose which sensor data to be
shown on the graph, whether to show grid on the right
pane, and the title of the graph.
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Graph Settings

Figure 5-14 Graph Type Tab Page

Select Graph Range:

The user can choose the value range on the x-axis and y-
axis in the Graph Range tab page of the Graph Settings
dialog box. To display the Graph Settings dialog box,
click any place in the right pane so that pane has the focus,
then click Option->Graph Settings menu item to display
the Graph Settings dialog box. To bring the Graph
Range tab page, the user can simply click the page header
of the Graph Range tab page. Figure 5-15 shows the
Graph Range tab page of the Graph Settings dialog box.
This is the place where the user can choose the graph range
on the x-axis and y-axis.
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Graph Settings

Figure 5-15 Graph Range Tab Page

To choose the range of Y-axis, the user first click the User
Defined radio button in the Y-Axis (Data Value) Range
group box, then the user can specify the top value and the
bottom value in the Data Value Range (Y-axis) group
box.

If the user select the Default radio button in the Y-Axis
(Data Value) Range group box, the ProRAE-Suite
software will scale the range of Y-axis by itself to cover
the maximum data value on y-axis.

To choose the range of X-axis, the user first click the User
Defined radio button in the X-Axis (Data Time) Range
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group box, then specify the start time fields in the Start
Time (X-axis) group box and the end time fields in the
End Time (X-axis) group box.

If the user select the Default radio button in the X-Axis
(Data Time) Range group box, the ProRAE-Suite will
scale the range of X-axis by itself to cover the every data
points on x-axis.
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5.6.6 Export the Displayed Data to a Text
File

The ProRAE-Suite software allows the user to export the
displayed text to a tab delimited text file so that Microsoft
Execl® can read it directly. To export the text displayed in
the right pane to a tab delimited text file, click Option ->
Export Text menu item, a Save As dialog box is
displayed. Specify the file name in the File name field,
then click the OK button to close the Save As dialog box.
A new file is created that can be read by Microsoft Excel®
directly. Appendix C shows a detailed step by step
instruction on how to export data as text file and use
Microsoft Excel® to open the text file.
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5.6.7 Export Graphic to a File

The ProRAE-Suite software allows the user to export the
displayed graph to a windows bitmap (.bmp) file or a
windows metafile (.wmf) file. To export the displayed
graph in the right pane to a windows bitmap or metafile
file, first click any place in the right pane to make sure that
the graph pane has the focus, then click Option -> Export
Graph menu item to display a Save As dialog box. Select
the export graph file type (.bmp or .wmf) in the Save as
type field, then specify the export file name in the File
name field. Click OK button to close the Save As dialog
box. The newly created graph file contains the graph
displayed in the right pane.
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5.6.8 Print the Logged Data

After viewing the data results, the user may print the data
to a printer in order to obtain a hard copy of the text or
graphic data report. First, click any place in the right pane
to set the focus on that pane, then select Print function
from the File sub-menu, or click the Print toolbar button
(a printer) to print the graphic or text data.

A printer setup dialog box will appear before the printing
starts so that the paper size, orientation, printer type, etc.
can be configured correctly.
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5.7 Upgrade the Datalog Option

To upgrade the datalog option, open the ProRAE-Suite
software. Do not open any configuration file or data file so
the ProRAE-Suite software has no client window open, as
shown in Figure 5-16.

= ProRAE-Suite

File  Communication JEfss

Enable the datalog capability of the instrument v

Figure 5-16 Main Window of ProRAE-Suite

Click Option -> Enable Datalog menu item, a message
box will appear to remind the user to connect the
instrument to the PC through the serial port. After making
sure that the Q-RAE monitor is connected to the PC, click
the OK button to start. After the ProRAE-Suite software
made successful contact to the instrument connected to the
PC, a dialog box is displayed, as shown on Figure 5-17.
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Enable Datalog Ed |

[atalog
|7 i Dizable % Enable
[,
iy

Authonization Code: I
Cancel |

Figure 5-17 Enable Datalog Dialog Box

Figure 5-17 shows that the instrument’s datalog feature is
currently enabled. If the user wants to change the datalog
option, click another datalog option radio button, and type
the three digit authorization code in the Authorization
Code field, then click the OK button to close the dialog
box. After the datalog option is changed, a message box
will appear on the screen to let the user know that the
datalog option is successfully changed.

Note: Each Q-RAE with datalogging function should be
shipped with a 3-digit authorization code. If the code is
missing, call the factory’s Customer Service Department to
obtain one.
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5.8 Upgrade the Firmware

To upgrade the firmware in the Q-RAE monitor, open the
ProRAE-Suite software. Do not open any configuration
file or data file so the ProRAE-Suite software has no client
window open, as shown in Figure 5-16. Click Option ->
Load Firmware menu item, a message box will appear to
remind the user to connect the instrument to the PC
through the serial port. After making sure that the
instrument is connected to the PC, click the OK button.
After the ProRAE-Suite software made successful contact
to the instrument connected to the PC, an Open file dialog
box is displayed, as shown on Figure 5-18. Select the
firmware file (.a07) which is going to be loaded into the
instrument, click the OK button to start the loading
process. After the firmware loading is finished, a message
box will appear on the screen to let the user know that the
firmware is successfully loaded into the instrument.

[, - ]

Lk i | 3 ProRiE -Suite

L] MiniRAE 2000_105.a07 ; 07 YRAE 7840 110.al
] MiniRAE2000_Y106.a07 . UhraRAE v224 an7 [y
%] MiniRAE2000_%107.207 5] UlraRAE_v230.a07
MUlRAE_Y216.a07 WRAE7800_Y109.a07
MURAE_Y220.a07 YRAE7800_Y110.a07

ppbRAE_W101.a07 WRAE 7840 v109.207
L] | i

File name: IDH.-’-‘-.E_"-.-"EEEI.aEI? Open I
Filez of wpe; IFirmware files [* a7 j Cancel |

Figure 5-18 Open Firmware File Dialog Box
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6. THEORY OF OPERATION

The Q-RAE monitor uses one to four different sensors to
measure a variety of gases. Up to two electrochemical,
toxic-gas sensors can be installed in the monitor to
measure inorganic toxic gases. A catalytic bead sensor is
used to measure combustible gases. An electrochemical
sensor is used to measure oxygen concentration.

LCD Display
Pump
Keypad ~_,
Micro-
Buzzer - processor

\( () ToxX1
\'o/
Light Battery [1 Serial (k) LEL
sensor | Port XY
Charger

Figure 6-1 Block Diagram of Q-RAE Monitor

A diaphragm pump draws the air sample into the sensor
manifold and then distributes it to all sensors.

A single chip microcomputer is used to control the
operation of the alarm buzzer, LED, pump and light
sensor. It measures the sensor readings and calculates the
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gas concentrations based on calibration to known standard
gases. The data are stored in non-volatile memory so that
they can be sent to a PC for record keeping. RS-232
transceivers provide a serial interface between the monitor
and the serial port of a PC. A 2-line by 16-character LCD
is used to display the readings. The user interacts with the
monitor through three keys on the front panel keypad.

A rechargeable Ni-Cd or Li-ion battery pack or a four AA
alkaline battery pack powers the monitor.

NOTE:

The printed circuit board of the monitor is connected
to the battery pack even if the power is turned off.
Therefore, it is very important to disconnect the
battery pack before servicing or replacing sensors or
any components inside the monitor. Severe damage to
the printed circuit board may occur if the battery pack
Is not disconnected before servicing the unit.
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7. MAINTENANCE

As shown in Figure 7-1, the major maintenance items of
Q-RAE are:

« Battery pack
« Sensor modules
o Sampling pump

Monitor Cover /

Battery Pack

| - Gas Plate

Water Trap

Figure 7-1 Main Components of Q-RAE
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7.1 Battery Replacement

When the display shows a flashing message “Bat”, the
battery requires recharging. The battery may be replaced
in the field (in area known to be non-hazardous) if
required. It is recommended to recharge the Q-RAE
monitor upon returning from field work. A fully charged
NiCd battery powers a Q-RAE monitor for 10 hours
continuous operation and an extended life Li-ion battery
for at least 18 hours. The charging time is less than 10
hours for a fully discharged battery. The built-in charging
circuit is controlled by two-step constant voltage / constant
current charging to prevent over-charging. The monitor
recognizes a Li-ion vs NiCd battery pack and allows the
user to perform a deep discharge only on NiCd batteries
but not on Li-ion batteries.

WARNING:

To reduce the risk of ignition of hazardous
atmospheres, recharge battery only in area
known to be non-hazardous. Remove and
replace battery only in area known to be non-
hazardous.




MAINTENANCE

Replacing and Recharging Battery Pack

1.
2.

Turn off power of the Q-RAE.

Refer to Figure 7-1, unscrew the two captured case
screws from the bottom of the monitor case and remove
the Q-RAE cover.

Unplug the battery from the battery jack, which is
connected to the PC board of the Q-RAE.

Connect the battery pack to the DC jack on an external
charging station (optional) for charging.

Replace a fully charged spare battery pack in the Q-
RAE.

Ensure the battery plug is securely connected to the Q-
RAE.

Close the Q-RAE cover and tighten the screws.

Replacing Alkaline Battery Adapter

1.

Insert four fresh AA size alkaline batteries into the
alkaline battery adapter. Make sure that the polarity of
the battery is correct.

Follow the same procedure as described above to
replace the battery adapter.

Note: The internal charging circuit is designed to prevent
charging to alkaline batteries when alkaline batteries are
installed in the monitor.
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7.2 Sensor Replacement

The hydrogen sulfide, carbon monoxide, combustible and
oxygen sensors all have an expected operating life. Under
normal operating condition, most sensors will lose their
original sensitivity after the expected operating life and
will need to be replaced.

Each sensor module in Q-RAE includes a non-volatile
memory, which records the manufacturing date of the
sensor. In the diagnostic mode, the microprocessor will
check the date code and display the expiration date of each
sensor. It is suggested that the user should replace the
sensor when the current date exceeds the expiration date of
a sensor. However, the sensor can be used beyond the
expiration date as long as the sensitivity is adequate for the
purposes of the measurements. Contact the service
department to determine the viablitiy of sensors that are
past expiration.

Sensor Replacement Procedure

The hydrogen sulfide, carbon monoxide, oxygen and
combustible sensors each have their own unique sensor
sockets in the Q-RAE monitor. This requires careful notice
to be paid when replacing sensors.

1. Turn off power of the Q-RAE.
2. Refer to Figure 7-1, open the monitor cover by

unscrewing the two captured screws from the bottom of
the monitor case. Disconnect the battery pack.
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Figure 7-2 Sensor Assembly of Q-RAE

3. Refer to Figure 7-2, carefully unscrew four No. 2
screws that hold down the gas piping plate to the
analog PCB and sensors. Remove the gas piping plate.

4. Refer to Figure 7-2, identify the location of a specific

sensor and remove the sensor by gently pulling upward.
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5. Plug a new sensor into the empty sensor socket. Make
sure that black line on the sensor label is lined up with
the white mark on the PCB and the sensor pins are
aligned with the socket before pushing down the
sensor.

6. Replace the gas piping plate and tighten the four screws
to hold down the sensors. Re-connect the battery pack.
Replace the monitor cover.

7. Turn on the power of the Q-RAE. The microprocessor
will automatically recognize the sensors installed and
configure the monitor accordingly.
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7.3 7.3 Sampling Pump Replacement

The sampling pump is positive displacement piston pump.
When approaching the end of the specified lifetime of the
pump, it will consume higher amount of energy and reduce
its sample draw capability significantly. When this occurs,
It is necessary to replace the pump.

1.

2.

Turn off power of Multi-gas Monitor.

Refer to Figure 7-2, open the monitor cover,
disconnect the battery pack, carefully unscrew four
No. 2 screws that hold down the gas piping plate to the
analog PCB and sensors. Remove the gas piping plate.

Carefully loosen the connector. Unscrew the two
screws that hold the pump assembly to the gas plate.
Disconnect the Tygon tubing that connects the pump to
the gas inlet port.

Install a new pump assembly. Connect the Tygon
tubing to the gas inlet port.

Refer to Figure 7-2, replace the gas piping plate and
tighten the four screws to hold down the sensors. Re-
connect the battery pack. Replace the monitor cover.
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8. TROUBLESHOOTING

To aid the user in diagnosing the monitor, the monitor has
a special diagnostic mode that can display critical, low
level parameters. Section 8.1 describes the operation of
the diagnostic mode.  Section 8.2 summarizes the
frequently encountered problems and suggested solutions.
Turning on the Q-RAE monitor in diagnostic mode and
using the troubleshooting table in Section 8.2, the user can
usually narrow the problem down to one or two areas and
correct the problem without having to return the monitor
for repair.

WARNING: The diagnostic mode allows the user to
set several low-level parameters that are very critical to
the operation of the monitor. Extra care should be
taken when setting these low-level parameters. If the
user are not familiar with these parameters and set
them incorrectly, it may cause the monitor to shut
down or malfunction. The diagnostic mode should be
used by qualified personnel only.
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8.1 Special Diagnostic Mode

To place the monitor into the special diagnostic mode, first
turn the monitor off. Next push and hold the [Y/+] key,
while still holding the [Y/+] key, also push and hold the
[MODE] key for at least two seconds or until the beep
stops. After the required delay, release both keys, the
monitor will now go through the normal start-up display
sequence and display a “Diagnostic mode” message. At
the end of the special mode start-up, the display will show
four numbers with a message “Raw.” These numbers are
raw sensor readings without calibration.

Other critical parameters of the monitor are available as
shown in Table 8.1. They can be reached by pressing the
[MODE] key repeatedly until the desired parameters are
displayed.
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Table 8.1
Key Action Display
Show raw readings
[MODE] Show sensor name
[MODE] Show battery type
[MODE] Adjust LCD contrast
[MODE] Check LEL power on/off
[MODE] Show clock, battery voltage and
temperature
[MODE] Show LEL & OXY sensor expiration
date
[MODE] Show H2S & CO sensor expiration date
[MODE] Adjust pump stall threshold
[MODE] Adjust back light on/off threshold
[MODE] Show serial number and toggle pump
speed
[MODE] Begin battery deep discharge
[MODE] Show battery duration time
[MODE] Communicate with PC?
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Here is a brief description of each diagnostic display and
how to interpret the displayed values:

1) Raw Sensor Readings

The raw sensor readings provide a quick diagnosis on the
response and the sensitivity of each sensor. When zero gas
(fresh clean air) is applied to the monitor, the raw sensor
readings typically should be between 100 to 1300 for LEL
sensor and between 1200 to 2300 for oxygen sensor. If the
raw reading is outside these ranges when zero gas is
applied, the sensor or the electronics may be defective.

When a specific gas is applied to the monitor, the
corresponding sensor should respond and the raw reading
should increase or decrease. If the reading of the
corresponding sensor does not change when the specific
gas is applied, then the sensor may be defective.

365 373
530 RAW 1879

2) Sensor Name

The carbon monoxide, hydrogen sulfide, oxygen and LEL
sensors have a non-volatile memory that contains the
sensor identification and other vital information, such as
manufacturing date, expected operating life, etc. If a
sensor is programmed and installed properly in the
monitor, the sensor name should be displayed. If the
sensor name does not show up in the display, then the
sensor may not be programmed properly or may be
defective.
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3) Battery Type

The Q-RAE monitor can be powered by either a
rechargeable Li-ion or NiCd battery pack or an alkaline
battery adapter. This display also shows the type of
battery that is installed inside the monitor.

4) Adjust LCD Contrast

This display allows the user to adjust the LCD contrast.
Press [Y/+] to increase the contrast and [N/-] key to
decrease the contrast. The bar graph shows the current
LCD contrast setting. If the display appears having dark
lines, press [Y/-] several times to see a more clear display.

5) Check LEL Power ON/OFF

This display shows the present condition of the LEL sensor
power and raw reading. The top display shows the
instantaneous reading of raw counts from the LEL sensor.
The bottom line shows if the LEL sensor is powered. By
pressing [N/-] key the power can be turned off. The [Y/+]
key turns powers to the LEL on.

6) Show Clock, Battery and Temperature
This display shows the real time clock, battery voltage in
raw count and temperature sensor reading.

7) Sensor Expiration Date

This display shows the expiration date (month and year) of
all the installed sensors in the Q-RAE monitor. The
expiration date is calculated based on the manufacturing
date and expected life of each sensor. This data is stored
inside each sensor when it is fabricated in the factory. If
the current date exceeds the expiration date of any sensor,
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the performance of the given sensor can no longer be
guaranteed. It is strongly recommended that the user
replace the sensor immediately to ensure proper operation
of the sensor.

8) Adjust Pump Stall Threshold
This display can be used to calibrate the pump stall
threshold. If the gas inlet is blocked but the pump does not
shut down, or the pump shut down too easily with a slight
blockage to the gas inlet, then the pump stall threshold
value may be set too high or too low. Use the following
steps to adjust the pump stall threshold.

a. The maximum and average pump current is displayed
on the first row: “Pump = xxx/zzz.” The current pump
stall value is displayed on the second row: “Stall = yyy
+/-.” The typical maximum pump current without any
blockage should be between 20 — 35 when the speed is
set to be “low” and the water trap filter is installed.
The typical stall value should be higher than the “un-
blocked” pump current by at least 5-8 counts.

b. The user can block the gas inlet for about ten seconds
and watch the pump current reading. The stall
threshold should set to be the average of the idle
reading and the block reading. That is: Stall = (Idle +
Block) / 2. The readings to be used in the calculation
are maximum pump current readings at the “xxx”
location of the unit.

c. Use [Y/+] or [N/-] key to increase or decrease the stall
value until it is the average of the idle reading and the
block reading. Press [MODE] key to exit this display.
If the threshold value is changed, a message “Save new
stall threshold?” will appear. Press [Y/+] to confirm
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the change, [N/-] or [MODE] key to abandon the
changes.

d. The pump stall threshold should be re-adjusted if the
pump speed is switched to “low” or “high”, or water
trap filter changed, or the firmware configuration has
been totally refreshed.

9) Check Backlight Threshold

This display can be used to adjust the LCD backlight
on/off threshold using the [N/-] or [Y/+] keys. A threshold
setting of 100 is appropriate for most all situations.

10) Serial Number and Pump Toggle

This display shows the unit’s serial number. If a pump is
installed and pump speed control circuit available, the
display “Pump=Low/(High)” may be toggled by pressing
the [N/-] key. Note that changes made here are only for
testing the pump condition and are not saved in the
nonvolatile memory (see Section 4.7 to update the pump
speed setting).

11) Display Battery Duration Time

This display shows the run time of the last time the unit
powered itself off due to a low battery. It is useful for
battery life testing.

12) Communicate with PC?

This display gives the option to communicate with the PC
for upload or download of configuration settings, logged
data, or new firmware.
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8.2 Troubleshooting Table

Table 8.2
Problem Possible Reasons & Solutions
Cannot turn on | Reasons:  Discharged battery.
power after Defective battery.
charging the Microcomputer hang-up.
battery
Solutions: Charge or replace battery.
Disconnect then connect
battery to reset computer.
No LED or Reasons: Defective LED or LCD
LCD back back light.
light
Solutions: Call authorized service
center.
Lost password | Solutions: Call authorized service
center.
Buzzer Reasons: Bad buzzer or wire
inoperative connection.
Solutions: Call authorized service

center.
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Problem Possible Reasons & Solutions
Reading Reasons:  Wrong calibration data.
abnormally Dirty sensor module.
high Dirty water trap filter.
Excessive moisture and
water condensation.
Solutions: Re-calibrate with the gas.
Clean sensor module.
Replace water trap filter.
Blow dry the sensor
module.
Reading Reasons: Incorrect calibration.
abnormally Low sensitivity to the
low specific gas.
Solutions: Calibrate the monitor.

Replace sensor.
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Problem Possible Reasons & Solutions
Read a small Reasons:  Sensor zero drifted.
background Unit was disconnected
value when from battery power or the
there is no sensor just plugged in.
detectable gas.
Solutions: Do fresh air calibration

(see Section 4.4.1).

Wait for reading to

stabilized.
Reading Reasons: Incorrect gas calibration.
jumping around Low sensitivity to cal gas.
randomly

Solutions: Calibrate the sensor.

Use different cal gas.
Cannot turn off | Reasons:  Microprocessor hang-up.
monitor or
corrupted Solutions: Disconnect and re-
characters in connect battery to reset
LCD display computer.

Call authorized service

center.
Calibration Reasons:  No standard gas input.
error message | Solutions: Make sure standard gas

flows into monitor.
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Problem Possible Reasons & Solutions
“Bat” message | Reasons: Discharged battery.
in operation

Solutions: Recharge battery.
“Voltage Reasons: Battery fuse blown or
too high wrong AC adapter or AC
message” in adapter does not fully
charge mode plug in.

Solutions: Check battery and
adapter. Detach and plug
in the adapter again.

Full scale Reasons:  Dirty or wet sensor

measurement in

humid Solutions: Clean sensor in ultrasonic

environment bath and dry thoroughly.
Replace water trap filter.

Excessive Reasons: Leaky inlet path.

pump noise or Defective pump.

no inlet air

vacuum Solutions: Check inlet connection.

Replace pump.
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APPENDIX A. QUICK REFERENCE GUIDE
1. TEXT MODE

| Display Instantaneous Reading & Sensor names alternately |

[N]+[MODE] for 3 seconds:
Password check
Wrong password: back to instantaneous display
Correct password: Enter Programming menu.
[N]: Toggle back light ~ [Y]: Test alarm/stop alarm

[MODE]
Display Battery voltage |
[MODE]
\ Print Reading? (if printer option is enabled) \
[MODE]
Communicate with PC? |

[Y]: Monitor will pause OK?
[Y]: Ready...
[N]: Return to Instantaneous display & Sensor names alternately

[MODE] or [N]
Return to Instantaneous display & Sensor names alternately
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2. DISPLAY MODE

| Display Instantaneous Readings & Sensor names alternately

[N]+[MODE] for 3 seconds:
Password check
Wrong password: back to instantaneous display
Correct password: Enter Programming menu.
[N]: Toggle back light  [Y]: Test alarm/stop alarm

[MODE]

| Display Peak values

[MODE]

| Display Min values

[MODE]

| Display STEL values

[MODE]

| Display TWA values

[MODE]

| Display Battery voltage

[MODE]

\ Print Reading? (if printer option is enabled)

[MODE]

| Communicate with PC?

[Y]: Monitor will pause OK?
[Y]: Ready...
[N]: Return to Instantaneous display

[MODE] or [N]

| Return to Instantaneous display & Sensor names alternately
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3. PROGRAM MODE

| Display Instantaneous Readings & Sensor names alternately

[N]+[MODE] for 3 seconds:
Password check
Wrong password: back to instantaneous display
Correct password: Enter Programming menu.
[N]: Toggle back light  [Y]: Test alarm/stop alarm

[MODE]

| Display Peak values

[MODE]

| Display Min values

[MODE]

| Display STEL values

[MODE]

| Display TWA values

[MODE]

| Display Battery voltage

[MODE]

| Display Clock / Run time / Internal temperature

[MODE] (For datalog function unit only!)

Configured for Manual datalog?

Yes: Start / Stop Datalog?

[Y] Start or Stop Datalog

[M] go to “Display LEL gas name”
No: Display Datalog mode

[MODE]

| Display LEL gas name

[MODE]

‘ Print Reading? (if printer option is enabled)

[MODE]

| Communicate with PC?

[Y1: Monitor will pause OK?
[Y]: Ready...
[N]: Return to Instantaneous display

[MODE] or [N]

| Return to Instantaneous display & Sensor names alternately
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PROGRAMMING MODE
Press [N] and [MODE] together for 3 seconds to enter, [MODE] to return

| Calibrate Monitor? (press [Y] to select menu) |

Y Fresh Air Calibration? l
/ Multiple Sensor Calibration? N
N Single Sensor Calibration?
Modify Span Gas Value?

‘Ny/ Change LEL Span Gas?

‘ Change Alarm Limits? ‘

Y\A Change High Alarm limit? l
i N

Change Low Alarm limit?
Change STEL alarm limit?

'\:y Change Average alarm limit?

View or Change Datalog? |

Y Clear All Data?
A Change Datalog Period?
Select Data Type?

Mode 4 View Datalog?
/ Enable/Disable Datalog?

Reset Peak and Minimum? l N

|Change Monitor Setup ? |

\ Change Site ID?

Y Change User ID? l N
Change Alarm Mode?

N Change User Mode?

Change Real Time Clock?

Change Backlight Mode?

Change Password?

Mode Change Pump Speed?
v / Change Averaging Method?

| Change Sensor Configuration? |

N \ Change LEL Gas Selection?
\ Enable / Disable Sensor? l N

Change Dilution Ratio?

Mode
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APPENDIX B. CORRECTION FACTORS

A partial list of correction factors for a number of
commonly used compounds for the LEL sensor is as
follows (refer to TN-156 at www.raesystems.com
for complete lists of correction factors):

Table B.1 Correction Factors for LEL Sensor

Compound LEL CF
Acetaldehyde 1.8
Acetic acid 3.4
Acetone 2.6
Ammonia 0.79
Benzene 2.1
Butadiene 2.5
Butane, n- 2.0
Carbon disulfide 4
Carbon monoxide 1.2
Cyclohexane 2.5
Dichloromethane 1.0
Ethanol 1.7
Ethene 1.5
Ethyl acetate 2.2
Ethyl benzene 2.8
Ethyl ether 2.3
Gasoline 2.1
Heptane, n- 2.4
Hexane, n- 2.3
Hydrogen 1.2
Hydrogen sulfide 2.3
Isobutane 1.8
Isobutene 1.7
Isopropanol 1.6
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Compound LEL CF
Methane 1.0
Methanol 1.5
Methyl ethyl ketone 1.7
Octane, n- 2.9
Pentane 1.8
Propane 1.5
Propene 1.5
Toluene 1.9
Vinyl chloride 1.8
Xylene, m- 2.7
Xylene, o- 3.0
Xylene, p- 2.8

The LEL correction factors in Table B.1 are measured
relative to methane gas. All measurements are at <5%
relative humidity and 250C, typically at 20-80% LEL. The
factors may change at higher concentrations or different
temperature and humidity conditions.
be multiplied by the reading to obtain the actual % LEL of
the gas, after calibration to methane.
factor of a gas is <1.0, then the sensitivity to the gas is

higher than that of methane.

The factors are to

If the correction
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APPENDIX C: DATA CONVERSION TO
MICROSOFT EXCEL® FOR Q-RAE

Q-RAE multi-gas monitors, configured with datalogging,
have 20,000 datalogging points built-in. The ProRAE-
Suite software provides data that can be converted into
other application programs such as Microsoft Excel®
(Version 7.0) for further data manipulation or graphing.

To convert the data file into Excel®, and to facilitate easier
data manipulation, the following procedure may be
followed:

1. Export the event data to a tab delimited text file, as
described in section 5.6.6: Export the displayed data
to a text file. Assume we have just exported the event
data to a file called TextEvent.txt in C:. To convert that
file to a MS-Excel file, open the MS-Excel software, as
shown in Figure C-1.

X Microsoft Excel - Bookl

ﬁﬁ\e Edit Wew Insert Format Tools Data Window Help —|=] x|

DeWHERy e s ez s siljnessz
aricl -w B rulE==Hs %, 88)E-5-A- 7
£l =] =]

A [ B [ ¢ [ 0o [ E [ F [ &6 [ H [ 1T =
1 | i
|2
ER
[ 4]
15|
|5 |
17|
|8
ER
[0
[11]

[12]
[13]
4] |
[15]
[16]
17 2
W[4 > bl Sheet1 (Sheetz 7 Sheets 7 1=l I LIJJ
Ready “7 T 4

Figure C-1 Excel Window
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2. Click the File->Open menu item to open the Open
dialog box, select the folder where the file
TextEvent.txt resides, and select the Files of type as
Text Files. Click to select the file TextEvent.txt, as
shown in Figure C-2.

[ ProRAE-SUite

=] Readme.bxt

tEwvent, bt

I I
fow s my oo T
R

Figure C-2 Open Dialog Box

3. Click the OK button; a Text Import Wizard dialog
box is open, as shown in Figure C-3.

Text Import Wizard - Step 1 of 3

T

1
L
2
=
4
[&]
=

Figure C-3 Text Import Wizard Dialog Box
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4. Click the Finish button; the dialog box disappears and
the event data are loaded into the MS-Excel software,
as shown in Figure C-4.

icrosoft Excel - TextEvent. txt

[ s [H Serial Mumber: 001234
| —

| |
Serial Nurber: 001234

Site ID:; 00000012 | |
Data Type: Awvg Sarnple Period: B0 sec
Last Calibration Tirme: 09/05/1996 19:00 | I

COfpprn) 02(%) | H2S (ppm)
50 235 50]
20 195 a0

[ COfpmAlarm  [02(%)  [Alarm [ H2S(ppmlAlarm  [LE

9/19/96 8:00 0.6 208 02
9/19/46 8:01 4 20.9 2.4
9719496 5:02 0.6 20,9 0.8
9/19/96 8:03 0.6 208 39
9/19/96 8:04 6.9 38
9719496 5:05 0.z 0.8

Figure C-4 File TextEvent.txt is Open

5. Click File->Save As menu item to save the loaded
event data to a MS-Excel file. Ensure that in the Save
As dialog box, the Save as type is Microsoft Excel
Workbook.

Graphing Q-RAE Data in Excel®

1. Open the Excel® data file that contains the data to be
graphed by selecting “File” and then *“Open.”
Highlight the columns that contain the data points.
Make sure that the header information is not
highlighted.

2. Go to the “Insert” menu, and under “Chart” elect “As
New Sheet.”



APPENDIX C

3. The first step of the ChartWizard will appear. In the
“Range” area, the cells that were highlighted on the

chart will be denoted.

ChartWizard - Step 1 of 5 B E |

If the selected cell: do not contain the data wou wizh to chart, select a new

Tange now.

Inziude the cells containing raw and calunn labels if you want those labels b

appear on the chart,

Bange: [ERISETR{NE

Cancel | < Bacl I MHedt I Finizh

Press the “Next” button to contin

ue.

4. The next step will show the different chart types. For
this example, the “Line” chart has been selected.

Chartwizard - Step 2 of 5

Select a chart type:

Area Bar Column
Doughnut Radar #' [Scatter) Combination
| P
..I e
s
2-D Bar 3D Column 3D Line 3D Pie 3D Surface

Cancel | < Back I Mext > I

Finizh

Press the “Next” button to continue.

5. Step 3 of the ChartWizard give additional choices for
the line chart, including data markers and gridlines. In
this example, number 4 has been selected, so there will

be markers and gridlines.
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Chartwizard - Step 3 of 5

Press the “Next” button to continue.

6. Previewing the chart will ensure that the correct
columns were chosen in the spreadsheet that comprises
the chart. Press the “Next” button to continue.

7. The final step is where the chart title and axis titles may
be added. After these are added, press the “Finish.”

8. A sample of a finished chart is below. For additional
information and other modifications that can be made
to the Excel® chart, please refer to the Excel®
instruction manual.







APPENDIX D

a3 a a a 3

a2 a aaa 3

a

a a a 3a

a

RAE SYSTEMS TECHNICAL NOTES

TN-102 Facts About PID Measurement

TN-103 External Datalogger Interface to MiniRAE PID
TN-104 Partial List of lonization Potentials

TN-105 MiniRAE PID Battery Characteristics

TN-106 Correction Factors, lonization Potentials, and
Calibration Characteristics

TN-108 MiniRAE PLUS PGM-76 and 76IS ProRAE 76
Software Upgrade for PGM-75

TN-109 MiniRAE Professional PID Zero Drift

TN-112 MiniRAE PLUS Datalogger Data Conversion to
Microsoft Excel version 5.0

TN-113 Calibration Procedures for ModuRAE PDM-10A
TN-114 ToxiRAE Sensor Specifications

TN-115 ToxiRAE Toxic Gas Monitor (PGM-35) at a Glance
TN-116 ToxiRAE Oxygen Monitor (PGM-36) at a Glance

TN-117 ToxiRAE Combustible Gas Monitor (PGM-37) at a
Glance

TN-118 Use of RAE PIDs for Soil Headspace Measurements

TN-119 Calculation of STEL, TWA, Min., Max., and Average
Values for ToxiRAE PID.

TN-120 Measuring Correction Factors for Volatile Compounds
with MiniRAE 7 and ToxiRAE PIDs

TN-121 CO Sensor Cross-Sensitivity and Removal with
Charcoal Filter

TN-122 MiniRAE Compliance with EPA Method 21

TN-123 Diagnostic Modes for RAE Instruments

TN 124 PID Lamp Characteristics

TN 125 Creating Custom Correction Factors and Gas Names
for the ToxiRAE PID

TN-126 Interchangeability of Sensors in PGM-35 and PGM-50

TN-127 Benzene-Specific Measurements in Petroleum
Hydrocarbons using the UltraRAE

TN-128 ToxiRAE PID Communications Problems

TN-130 Setting Alarm Limits for Mixtures

TN-131 Verifying and Fixing Gas Alarm Limits
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TN-132 Upgrading RAE Instruments Firmware

TN-133 Methylene Chloride-Specific Measurements using the
UltraRAE

TN-134 UltraRAE Bar Code Reader Patterns an Adjustments

TN-135 UltraRAE Firmware & Tube Data Upgrade
Procedures

TN-136 UltraRAE Operations Tips

TN-137 Exiting Diagnostic Mode for ToxiRAE LEL

TN-138 RAE System Year 2000 Compliance

TN-139 UltraRAE Communication with NT

TN-140 Extension Tubing Volume and Delay Time

TN-141 MultiRAE Remote Control Functions

TN-142 MiniRAE 2000 Preprogrammed Compound Library

TN-143 Accuracy Comparisons of Gas Detection Tubes

TN-144 Handling LEL Sensor Poisoning

TN-145 Proper Care of Nickel Cadmium Battery Packs

TN-146 Turning On UV Lamps in a PID Monitor

TN-147 UltraRAE: Butadiene Specific Monitor

TN-148 Measurement of Phosphine (PHs) by PID In the Food
Storage industry

TN-149 PGM-30 UV Lamp Care

TN-150 Understanding the ppbRAE

TN-151 Electrochemical Sensor Replacement and Maintenance

TN-152 Effects of Operating Conditions on Oxygen Sensors

TN-153 TC Sensor Applications and Correction Factors

TN-154 SampleRAE Correction Factors

TN-155 2-Year Oxygen Sensor Installation and Calibration

TN-156 Correction Factors for Combustible Gas (LEL) Sensors

TN-157 Moisture Exchange Tubes for Humidity Control of Test
Gases

TN-158 Conversion of PID Readings to Methane Equivalent
Response

TN-159 Nerve Agent Measurements by PID

TN-160 Upgrading MultiRAE/QRAE Ni-Cd Battery Pack

Technical Notes are available at www.raesystems.com.
See Appendix F to order hard copies of Technical Notes.
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APPENDIX E

RAE SYSTEMS APPLICATION NOTES

AP-200 PIDs and Aircraft Wing-tank Entry

AP-201 Measuring Ammonia (NHs) with PIDs

AP-202 ABCs of Gases in Industry

AP-203 PID as a Hazmat Response Tool

AP-204 Pulp & Paper: Measuring Turpentine & CIO,

AP-205 Measuring Heat Transfer Fluids with a PID

AP-206 Guide to Atmospheric Testing in a Confined
Space

AP-207 PIDs as an Arson Investigation Tool

AP-208 HAZMAT User List

AP-209 UltraRAE User List

AP-210 North American RAE User List

AP-211 PIDs for Continuous Monitoring of VOCs

AP-212 PIDs for Indoor Air Quality

AP-213 ModuRAE PID Configuration and Applications

AP-214 Environmental Applications for PIDs

AP-215 Gas Detection in the Marine Industry

AP-216 Weapons of Mass Destruction

AP-217 Confined Spaces in the Construction Industry

AP-218 Lengthening the Interval Between Calibration
Checks

AP-219 Using PIDs for 10% of LEL Decisions
AP-220 Using PIDs in Clan Lab Investigations

AP-221 PIDs for Exposure Risk in Unknown
Environments
n  AP-222 CO & Natural Gas Detection for Fire Department
Engine Companies
AP-223 ppbRAE User List
AP-224 Understanding the CDRAE and its Applications

Application Notes are available at www.raesystems.com.
See Appendix F to order hard copies of Application Notes.
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APPENDIX F

LITERATURE REQUEST

Application and Technical Notes are available at
www.raesystems.com in PDF format for printing.

For hard copies, Photocopy this page and fax to:
Attn: Literature Department
1.408.952.8480 FAX

Please send me the following information:

Name:

Company:

Mailing Address:

City, State, Zip:

Country:

Telephone:

Fax:

Technical Notes:
(just list TN #)

Application Notes:
(just list AP #)

Comments:

Thank you, RAE Systems Sales & Marketing Department



APPENDIX G

APPENDIX G. REQUEST FORM FOR
RETURN MATERIAL AUTHORIZATION

Need to send your monitor in for repair,
calibration, service or upgrading?

For proper tracking of your equipment please obtain an RMA
Number before returning the monitor.
Photocopy this page and fax to Attn: Service Department:

1.408.952.8480
Electronic RMA requests can also be made through our website:
Www.raesystems.com

We will return fax the RMA Number and instructions on how to ship.

We must obtain the following information in full:
Name:

Company:

Shipping
Address:

City, State, Zip:

Telephone:

Fax:

Serial number:

Model:

Reason for
return:

Note: When returning an instrument for repair, please send only the monitor that needs
to be worked on without any additional accessories. Only send accessories with the
instrument when they are also in need of repair. This will help us get your equipment
back to you in an efficient manner.

Thank you, RAE Systems Service Department



RAE Systems, Inc., Main Office

3775 N. First St.
San Jose, CA 95134 -1708 USA

Contact Numbers
Telephone
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